Contents

Chapter 1: Introduction ................................................................. 1
OVERVIEW .............................................................................. 1
What Is Bunkspeed Shot? .......................................................... 1
How Bunkspeed Shot Works ................................................... 1
Key Features ........................................................................ 2
SYSTEM REQUIREMENTS ......................................................... 3
INSTALL, LICENSE, AND RUN BUNKSPEED SHOT .................. 5
BUNKSPEED CONTENT FOLDER ........................................... 7
HELP RESOURCES ................................................................ 7

Chapter 2: Bunkspeed Shot Tutorial ............................................. 8
LAUNCH BUNKSPEED SHOT .................................................. 8
IMPORT A 3D MODEL ............................................................. 9
USE THE CAMERA ................................................................ 9
ASSIGN AND EDIT MATERIALS ............................................ 9
IMPORT AN HDR ENVIRONMENT IMAGE ............................... 11
IMPORT A BACKPLATE IMAGE ............................................ 12
OUTPUT THE IMAGES .......................................................... 12
  Quick Screenshot .............................................................. 12
  High Quality Rendering ................................................... 13

Chapter 3: Overview of the User Interface ................................. 14
MAIN MENU ............................................................................ 15
  File Menu .......................................................................... 16
  Edit Menu .......................................................................... 16
  View Menu ......................................................................... 17
  Project Menu ...................................................................... 18
    Model ............................................................................... 18
    Material .......................................................................... 18
    Environment .................................................................... 19
    Backplate ......................................................................... 19
    Camera ............................................................................ 19
    Project ............................................................................. 19
  Tools Menu ......................................................................... 20
    Options Dialog ............................................................... 21
  Help Menu ......................................................................... 24
  Progress Bar ...................................................................... 24
VIEWPORTS ................................................................. 24
  3D Viewport .......................................................... 24
  Image Viewport ..................................................... 24
  Rendering Viewport ............................................... 24
  Login System .......................................................... 24

TOOLBAR ........................................................................ 25
  Main Toolbar ............................................................. 25
    Raytrace On, Off, Blend ........................................... 25
    Selection Tools ....................................................... 25
    Object Manipulation Tools ......................................... 25
    Camera Control ....................................................... 26
    Ray Brush .............................................................. 27
    Render Button ........................................................ 27
  Camera Toolbar .......................................................... 27

PALETTE ........................................................................ 28
  Model Tab ................................................................. 29
    Model Tree ............................................................ 29
    Model / Part Parameters ........................................... 30
  Material Tab .............................................................. 31
    Material Tree ........................................................ 31
    Material Parameters ............................................... 31
    Texture Parameters ................................................ 32
  Scenes Tab .................................................................. 33
    Scene Tree ................................................................ 33
    HDR Environment Parameters .................................... 33
    Backplate Parameters ............................................. 34
    Context-Sensitive Scene Menu ..................................... 34
  Cameras Tab ............................................................... 35
    Camera Tree ........................................................... 35
    Camera Parameters ................................................ 35
  Library Tab .................................................................. 36
    Camera Library ......................................................... 37
    Environments Library ............................................... 37
    Image Library .......................................................... 37
    Materials Library ...................................................... 37
    Models Library ........................................................ 38
    Plates Library .......................................................... 38
    Project Library ........................................................ 38
    Texture Library ......................................................... 38
    Web Libraries .......................................................... 38
  Color Picker .................................................................. 39

CONTEXT SENSITIVE MENU .................................................. 40

THE CAMERA ................................................................. 40
  Automatic Perspectives ............................................... 40
  Basic Camera Movements ........................................... 41
    Rotate the Camera ..................................................... 41
    Pan the Camera ........................................................ 41
    Zoom the Camera ...................................................... 41
    Twist the Camera ...................................................... 41
    Change the Look At Point .......................................... 42
  Additional Camera Controls ......................................... 42
    Reset the Camera ...................................................... 42
    Lock / Unlock ............................................................ 42
    Use Camera Presets .................................................. 42
    Save a Camera to a File ............................................. 42
Chapter 4: Working with 3D Models

IMPORTING MODELS
- Importing OBJ Files
- Importing SolidWorks Files
- Importing Pro/ENGINEER and CREO Files
- Importing Rhino Files
- Importing SketchUp Files
- Importing IGES Files
- Importing STEP Files
- Importing WIRE Files

TRANSFORMING MODELS
- Numerical Transforms
- Using the Transform Manipulator
  - Move Manipulator
  - Scale Manipulator
  - Pivot Manipulator

HIDING / SHOWING MODELS AND PARTS

MORE ABOUT PARTS
- Symmetry
- Part/Normals Control
- Splitting Models and Parts
- Texture Mapping on Parts
  - Texture Mapping on Parts using the Texture Manipulator

DELETING MODELS AND PARTS

Chapter 5: Working with Materials

DISPLAY THE MATERIAL LIBRARY

APPLY MATERIALS
- Apply Materials to Parts in Models
  - Use a Material in the Material Library
  - Use a Material in the Open Project

CREATING, EDITING, AND SHARING MATERIALS
- Create and Edit Materials
- Add and Edit Textures in Materials
  - Mapping Textures
- Share Your Materials

DECALING
- Creating Decals
- Editing Decals

Chapter 6: Working with Scenes

CREATE AND EDIT HDR ENVIRONMENT IMAGES
- Load a HDR Environment Image
  - Tune HDR Environment Images

CREATE AND EDIT BACKPLATE IMAGES
- Load Backplate Images
Chapter 7: ShotShotSaving and Outputting ........................................ 66
          SAVING ........................................................................ 66
            OUTPUTTING IMAGES ..................................................... 66
              Snapshot (High Speed) ................................................. 67
                Take a Snapshot ....................................................... 67
              Render (High Quality) ................................................ 68
                Render Options ....................................................... 68
              Render (Animations) .................................................. 70
                Animation Options ................................................ 70
                Render Options ...................................................... 70
              The Ray Brush .......................................................... 71
                Using the Ray Brush ................................................. 71

Chapter 8: Appendix .................................................................... 72
          HOT-KEYS ...................................................................... 72
          SUPPORTED IMPORT FORMATS ...................................... 75
            Import Formats for 3D Models ....................................... 75
            Import Formats for HDR Environments ....................... 76
              OpenEXR (EXR) ......................................................... 76
                High Dynamic Range Image (HDR) ......................... 76
            Import Formats for Backplates and Textures ............... 77
          TYPES OF MATERIALS IN BUNKSPEED SHOT ................... 77
            Anisotropic ............................................................... 78
            Emissive ................................................................. 78
            Flat .......................................................................... 78
            Generic ................................................................. 79
            Glass ...................................................................... 80
            Gem ......................................................................... 80
            Matte ...................................................................... 80
            Metal ...................................................................... 80
            Metallic Paint ......................................................... 81
            Paint ...................................................................... 81
            Plastic ................................................................. 81
Chapter 1: Introduction

OVERVIEW

What Is Bunkspeed Shot?

Imagine: High quality, interactive, photorealistic renderings of your designs. Instantly. In real-time. No more waiting. No more complicated software packages and costly experts. With the power of Bunkspeed Shot™, rendering becomes a simple and important part of your creative process and work flow – from concept to marketing.

Bunkspeed Shot uses cutting edge technology to bring renderings alive, allowing you to compose and manipulate high-resolution 3D digital images in real-time. Designs are rendered on the fly, with stunning realism and full photorealistic detail using materials, lighting, shadows and reflections that look so real, you can say goodbye to physical prototypes. What used to take a specialist hours can now be done by anyone in minutes.

How Bunkspeed Shot Works

Bunkspeed Shot is a fully raytraced rendering environment, by default. (You can pause or disable raytracing to speed up editing on lower power hardware, and then enable raytracing as a final step.) The software is constantly updating the scene using raytracing by taking full advantages of all available CPUs and CUDA GPUs.

Unlike traditional 3D applications, you do not need to guess and check before generating final results. In Bunkspeed Shot, you interact with the final result at all times, even while animating.

A Bunkspeed Shot project consists of an environment sphere that includes a transparent ground plane for accurate shadowing, and an HDR environment image that maps to the spherical environment. No further lighting setup is required, although additional sources of light are available.
Key Features

- Intuitive out of the box
- All new, state-of-the art user interface using the latest UI development libraries:
  - New Toolbar with extended capabilities
  - Central Asset Library makes all materials, textures, and environments accessible in one palette, with drag-and-drop functionality throughout
  - Interactive WYSIWYG rendering of fully raytraced environments
  - Model tree of objects and their parts supports direct interactions
  - Improved camera control and view management
  - Enhanced realtime interactions
- Fast import of many file formats, including the latest native CAD formats
- Enhanced creation, tuning, and assignment of scientifically accurate materials
- Always correct lighting, shadows, and reflections from HDR environments and raytracing
- Multi-threaded architecture takes full advantage of multi-core CPUs, as well as CUDA GPUs
- Accurate simulation of camera optics
- HD rendering with alpha channels
- Ability to share projects, cameras, and materials.
- Full set of animation tools and support.
## SYSTEM REQUIREMENTS

Bunkspeed Shot has the following minimum and recommended system requirements.

<table>
<thead>
<tr>
<th>Configurations and Hardware Requirements</th>
<th>Bunkspeed Shot 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Realtime Resolution</strong></td>
<td>up to 4096 x 2048 (with a 4K display)(^a)</td>
</tr>
<tr>
<td><strong>Rendering Resolution</strong></td>
<td>unlimited</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Windows 7, 64bit</td>
</tr>
<tr>
<td><strong>(64bit Windows 7 highly recommended)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>CPU Minimum</strong></td>
<td>Quad-Core CPU</td>
</tr>
<tr>
<td><strong>CPU Recommended</strong></td>
<td>Quad-Core CPU or Higher</td>
</tr>
<tr>
<td><strong>Memory Minimum</strong></td>
<td>4GB of RAM</td>
</tr>
<tr>
<td><strong>Memory Recommended</strong></td>
<td>8+GB of RAM, 64bit OS</td>
</tr>
<tr>
<td><strong>Disk Space</strong></td>
<td>1 GB or more (for application + assets)</td>
</tr>
<tr>
<td><strong>Tested Graphics Cards</strong></td>
<td></td>
</tr>
<tr>
<td><strong>(120+ CUDA cores, 1+ GB Graphics Memory(^b))</strong></td>
<td>NVIDIA GeForce GTX 580</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce GTX 590</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce GTX 480 (1.5 GB, 480 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce GTX 485M (2.0 GB, 352 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce GTX 470 (1.28 GB, 448 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce GTX 465 (1.0 GB, 352 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce GTX 460 (1.0 GB, 336 CUDA cores)</td>
</tr>
<tr>
<td>Certified Graphics Cards (Multiple cards, 120+ CUDA cores, 1+ GB vRAM)(^c)</td>
<td>NVIDIA Quadro 6000 (6.0 GB, 448 CUDA cores)</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>NVIDIA Quadro 5000 (2.5 GB, 352 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA Quadro 4000 (2.0 GB, 256 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA Tesla C2070 (3 GB, 448 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA Tesla C2050 (6 GB, 448 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA Quadro FX 5800 (4.0 GB, 240 CUDA cores)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA Quadro Plex 2200 D2 (8 GB, 480 CUDA cores)</td>
</tr>
<tr>
<td>Graphics Driver (Certified)</td>
<td>275.xx (XP 64)</td>
</tr>
<tr>
<td></td>
<td>275.xx (Win7 64)</td>
</tr>
<tr>
<td></td>
<td>275.xx (Vista 64)</td>
</tr>
<tr>
<td>Monitor</td>
<td>1280 x 1024 or higher</td>
</tr>
<tr>
<td>Licensing</td>
<td>Node Locked or Floating Licence</td>
</tr>
<tr>
<td>Internet</td>
<td>Required for download and licensing</td>
</tr>
<tr>
<td>Boost</td>
<td></td>
</tr>
</tbody>
</table>

### Apple Specifications

- **BootCamp**: Windows XP 64bit, Windows Vista 64bit, Windows 7 64bit
- **CPU Minimum**: Dual Core CPU
- **CPU Recommended**: Quad-Core CPU or Higher
- **Memory Minimum**: 4GB of RAM, 64bit OS
- **Memory Recommended**: 4GB of RAM (for larger objects), 64bit OS
- **Disk Space**: 1 GB or more (for application and assets)
- **Graphics Cards** supported by Mac:
  - NVIDIA Quadro 4000 (2.0 GB, 256 CUDA cores)
  - NVIDIA Quadro 4800 (1.5 GB, 192 CUDA cores)
  - NVIDIA GeForce GTX 285 (1.2 GB, 240 CUDA cores)

\( ^a\) As you increase realtime resolution, performance decreases.
\( ^b\) We recommend using the latest "Fermi" generation of nVidia GPU's, which out-perform previous generations.
\( ^c\) The amount of GPU memory determines the size of the model that you can load while in GPU mode. About 5 Million Polys can be loaded into 1 GB of memory.
INSTALL, LICENSE, AND RUN BUNKSPEED SHOT

1. Download the Bunkspeed Shot file from Bunkspeed’s web site.

2. On your local computer, unzip the file and run it. Follow the instructions on the screen to complete the installation.

3. When you run Bunkspeed Shot for the first time, then you will probably see the following screen first (see image below). In this No License screen, click Licensing to display the Bunkspeed Licensing options.

4. In the Bunkspeed Licensing screen, select one of the following options:
   – **ACTIVATE**: Enter the Activation ID you received from Bunkspeed, or click Use Floating License and enter the address of the license server on your network on the Internet (see images below)
   – **PURCHASE**: Select this option to open a web browser to Bunkspeed’s web site, where you can buy a license and receive an Activation ID.
   – **Back**: Return to the previous No License screen.
5. After handling the licensing, the next step on first run is to select the location of the folder under which Bunkspeed Shot stores all your project assets, when prompted.

![Folder Selection](image)

6. In subsequent runs of Bunkspeed Shot, the Welcome Screen (see figure below) gives you following options.

![Welcome Screen](image)

**RENDERING MODE**

Different systems can produce different results with each render mode. You should try each mode before settling on the mode that works best for you:

- **CPU Only**: Select this option if you have anything other than a nVidia CUDA-enabled GPU with 512 MB VRAM or better.
- **GPU Only**: Select this option if you have a much better graphics card that your CPU.
- **Hybrid**: Select this option if you have an appropriate nVidia card as well as a good CPU.

**PROJECT TO OPEN**

- **New Project**: Creates a new project that’s empty except for the default HDR environment image to provide lighting.
- **Open Project**: Displays a file loader so you can locate and open a native Bunkspeed Shot file (BIF format) in an arbitrary location.
- **Recent Projects**: Lets you open a project from a list of recently opened projects. On first run, this list will be empty, of course.
- **Sample Projects**: Use the Podium project to do the “Bunkspeed Shot Tutorial” on page 8.
**BUNKSPEED CONTENT FOLDER**

When you install Bunkspeed Shot, it asks you for a location to create a “Content” folder. The Content folder contains the following sub-folders to store assets for your projects:

- **Cameras**: Stores default cameras, as well as cameras that you have saved.
- **Environments**: Stores high dynamic range images (HDR and EXR format) for use in environments.
- **Images**: Stores renderings and snapshots.
- **Materials**: Stores the materials in your Material Library. The contents update when you add a material to the Library.
- **Models**: Stores model files. By default, Bunkspeed Shot will look in this folder first when you import a model.
- **Plates**: Stores standard 2D images for use in backplates.
- **Projects**: Stores native project files (BIF format).
- **Textures**: Stores 2D textures for use in materials.

**HELP RESOURCES**

The following instructional resources are available for Bunkspeed Shot:

- **Contents**: Displays the *Bunkspeed Shot User Guide* you are reading now. You can learn the essentials of Bunkspeed Shot in less than one hour by doing the “Bunkspeed Shot Tutorial” on page 8 in this *User Guide*. And you can quickly get details on any Shot-related subject in this *User Guide*.
- **About**: Provides the version number and similar information for your copy of Bunkspeed Shot.
- **System Info**: Summarizes how well Shot will likely perform using your OS and hardware. Advises you of things that could be upgraded to improve performance.
Chapter 2: Bunkspeed Shot Tutorial

The tutorials in this chapter teach you the basics of Bunkspeed Shot. Prepare to be rendered speechless (literally) in just 30 minutes! You can create typical Bunkspeed Shot projects in the following phases:

- Launch Bunkspeed Shot.
- Import a 3D Model (a.k.a. “object” or “mesh”) to serve as a 3D subject in your Bunkspeed Shot project.
- Use the Camera.
- Assign and Edit Materials for your models.
- Import an HDR Environment Image to provide lighting for your models.
- Import a Backplate Image to provide a high quality background.
- Output the Images in various formats.

LAUNCH BUNKSPEED SHOT

1. To run Bunkspeed Shot, select Bunkspeed Shot in the Start Menu. The Bunkspeed Shot Welcome Window appears – unless this is the first time you have run this installation of Shot, in which case refer to Install, License, and Run Bunkspeed Shot.

2. In the Welcome Window, select New Project to load an empty scene with the default environment image.
IMPORT A 3D MODEL

3. Next, import a model into your new project: Select Project > Import Model from the Main Menu to display a file loader you can use to open any obj model file in the Bunkspeed Content > Models folder.
   - Accept the default options in the Import Model dialog box.
   - Depending on the size of the file and your computer’s hardware, it may take a few seconds for the model to fully load.
   - Once the model loads into the open scene, Bunkspeed Shot will show your project in real-time.

For details on models, see “Chapter 4: Working with 3D Models” on page 43.

USE THE CAMERA

You can move the current camera relative to the look-at point. You can of course change the look-at point too. (The look-at point is the point in 3D space where the camera focuses, rotates around, and zooms towards.)

4. To move the camera, HOLD the ALT-KEY and use the mouse as follows:
   - Rotate: LEFT-CLICK-HOLD inside the Viewport and DRAG the MOUSE to orbit the camera around the focal point.
   - Pan: MIDDLE-CLICK-HOLD inside the Viewport and DRAG the MOUSE to move the camera and focal point together.
   - Zoom: RIGHT-CLICK-HOLD inside the Viewport and DRAG the MOUSE to zoom the camera in / out, relative to the focal point.
   - Perspective: ROTATE the MOUSE WHEEL to dolly and change the focal length of the virtual lens.
   - Look-At: Or hold both the CONTROL and ALT-KEYS, and RIGHT-CLICK on a new look-at point in the 3D Viewport.

For details on cameras, see “The Camera” on page 40.

ASSIGN AND EDIT MATERIALS

In Bunkspeed Shot, a “material” is a scientifically accurate simulation of a substance such as polished aluminum, glossy paint, glass, emerald, wood, rubber, etc. By mapping materials on models, the models assume an uncanny realism.

Each “type” of material in Bunkspeed Shot is defined by a unique set of parameters, including up to four textures (color, specular, alpha, bump). Different materials of the same type have the same parameters with different values. Bunkspeed Shot comes with a variety of materials. You can create new materials by modifying the parameters of existing materials, and by importing materials created by others. For details on materials, see “Chapter 5: Working with Materials” on page 55.
Here’s how you map a material onto a part in a model:

5. In the Palette, select the **Library Tab** to activate Library Mode.

6. To display the Material Library, select **Materials** in the drop-down menu near the top of the Library Tab. The Materials Library contains all the materials (in BMF format that can be shared and emailed) in the `Bunkspeed Content \ Materials` folder, by default. Notes:
   - You can obtain materials from the Bunkspeed web library. For instructions, see “Web Libraries” on page 38.
   - Materials can also be created via the right-click menu in the material tab of the Palette.

7. **DRAG-AND-DROP** any material from the Materials Library to the target part in the model in the 3D Viewport. This action accomplishes two things:
   - The material is mapped to the target part.
   - The material is added to the current project, and will be packaged and saved with the current project – making the material independent of your Material Library.

Do not confuse the Materials Library in the Library Tab with the Materials Tab:

- The Materials Library is accessible via the Library Tab of the Palette. The Materials Library contains all the material files in the `Bunkspeed Content \ Materials` folder, by default – regardless of whether or not these materials are used in the open project.
  - The materials in the Material Library are independent of specific projects, making the entire Material Library available to all projects.
  - You cannot directly edit a material in the Material Library. But you can bring a material from the Material Library into the open project, and then edit the material with the parameters in the Material Tab, and save the modified material as a new material in the Material Library.
  - Shot saves materials in BMF format in the `Bunkspeed Content \ Materials` folder, by default. You can copy, share, and even email BMF files to other Shot users.

- The Materials Tab of the Palette contains only the materials that have been added to the open project.
  - Note: In the Materials Tab, LEFT-CLICK any material to display its parameters. You can optionally edit these parameters to modify the material. Your edits will effect instances of the material on parts in the open project, but will not affect the Material Library.
IMPORT AN HDR ENVIRONMENT IMAGE

High dynamic range images (HDR) can contain a far greater contrast range and color depth than regular 2D images. HDR images accomplish this by using special formats, such as HDR and EXR, that describe RGB colors with 32-bits per channel of data. That’s a lot more color and luminance information than standard 2D images using 8-bits per channel.

Bunkspeed Shot lets you load an HDR image onto an environmental sphere that contains your entire scene. The HDR image will then radiate light into your scene from all directions, according to the RGB values of individual pixels in the HDR image. Here’s how:

8. To display the Environments Library, LEFT-CLICK the Library Tab in the Palette, and then select Environments in the drop-down menu therein. The Environments Library contains all the HDR images in the Bunkspeed Content \ Environments folder, by default.

9. In the Environments Library, DRAG-AND-DROP any HDR image into the 3D Viewport. This action applies the HDR image to the environment sphere containing the open project, causing the HDR image to provide the light in your scene.
   – Alternative: Double-click the environment icon in the Environment Library to load it into the environment of the open scene.
   – Alternative: New HDR environment images can also be loaded via the right-click menu in the Scene tab of the Palette.

10. You can tune an HDR image in Scenes Mode, as follows:
    – To activate Scenes Mode, LEFT-CLICK the Scenes Tab in the Palette (see the figure to the left). All environments that have been loaded into the open project are listed in the Scenes Tab of the Palette.
    – In the Scenes Tab, LEFT-CLICK the target environment image in the Environments Tree near the top, and adjust the Brightness parameter to change the total amount of light the environment image radiates into your scene.
    – Adjust the Gamma parameter to indirectly change the contrast of the environment image.
    – Experiment with changing other parameters in the Scenes Tab.

• Here’s another way to apply a different environment image to the open scene:
  i. Activate the Scenes Tab in the Palette.
  ii. In the Scenes Tab, double-click the icon of the environment you wish to load into the open scene.

For details on environments, see “Working with Scenes”.

Copyright © Bunkspeed, Inc. 2002-2011
IMPORT A BACKPLATE IMAGE

A backplate is a standard 2D image that provides a background for your scene, without affecting the lighting in the scene. By design, backplates do not emit light into the scene, and do not receive shadows. Also, backplates always remain in the center of the 3D Viewport, orthogonal to the camera, regardless of where you move the camera.

You can use a variety of 2D image formats, such as JPEG, as backplate images.

11. To display the Plates Library, LEFT-CLICK the Library Tab in the Palette, and select Plates in the drop-down menu. The Plates Library contains the backplate images in the Bunkspeed Content \ Plates folder, by default.

12. From the Plates Library, DRAG-AND-DROP any image therein into the 3D Viewport – placing the image in the background of your project. After loading a backplate image into the open project, the image will be listed in the Scenes Tab of the Palette.
– Alternative: New backplates can also be loaded via the right-click menu in the Scene tab of the Palette.

For details on backplates, see "Chapter 6: Working with Scenes" on page 61.

OUTPUT THE IMAGES

This section introduces you to outputting images from Bunkspeed Shot. For details, see "Chapter 7: ShotShotSaving and Outputting" on page 66.

13. Adjust your camera to position it and the model in the 3D Viewport, so as to them exactly as you want the output image of the scene.

Quick Screenshot

To output a quick snapshot of the scene on your screen, do the following:

14. In the Main Toolbar, LEFT-CLICK the All Configs render button to reveal the Snapshot, Render, and Animation icons or dialog box.

15. In the drop-down icons (or dialog box), select the Snapshot icon (or tab) to select a quick snapshot (i.e. a customized screen shot without raytracing).

16. Set the Snapshot options, and then CLICK Take Snapshot. Bunkspeed Shot saves the screenshot in the Images Library (the Bunkspeed Content \ Images folder by default).
High Quality Rendering

To output a high quality rendering of your scene, do the following:

17. In the Toolbar, LEFT-CLICK the **All Configs** render button to reveal the Snapshot, Render, and Animation icons or dialog box.

18. In the drop-down icons (or dialog box), select the **Render** icon (or tab) to display the Render dialog.

19. In the Render dialog, there are a few different types of rendering to choose from. The process for each type of high quality rendering is explained in detail in “Outputting Images” on page 66.

The rendering may take a few minutes, depending on your hardware. Bunkspeed Shot saves the rendering in the Images Library (the Bunkspeed Content \ Images folder by default).
Chapter 3: Overview of the User Interface

The Bunkspeed Shot User Interface contains the following elements:

- Main Menu
- Viewports
- Toolbar
- Palette
- Context Sensitive Menu
- The Camera
When Shot initially opens, you can choose between rendering modes. Your options include CPU Only, GPU Only, and Hybrid.

After selecting the rendering mode that best utilizes your particular hardware, you can then select **New Project** to start a blank Shot project, or **Open Project** to continue work on an existing Shot project.

When your project has finished loading, you can modify the UI of Shot as follows:

- To change the width of the Palette, drag its border with the mouse.

- To break the entire Palette away from its dock, Click-Hold-Drag any tab in the Palette. You can drag a free-floating palette anywhere on your screen.

- To dock a free-floating Palette, drag it near one of the edges of the Shot Window. Anchor arrows will appear on the left or right sides. Release the Palette on top the arrow on the desired side.

- To hide the Toolbar or HUD when it’s not in use, Click the pin at the upper right edge. To reveal a hidden Toolbar or HUD, just mouse-over the area it normally resides. Click the pin again to keep it visible.

### MAIN MENU

The **Main Menu** in Bunkspeed Shot includes the following pull-down menus:

- File Menu
- Edit Menu
- View Menu
- Project Menu
- Tools Menu
- Help Menu
- Progress Bar
File Menu

The File Menu provides the following options:

- **New Project**: Creates a new Bunkspeed Shot project. New projects are empty except for the default HDR environment image to provide lighting.

- **Open Project**: Lets you load an existing project from your hard drive or network.

- **Recent Projects**: Lets you select and open a project from a list of recently opened projects.

- **Open Image**: Lets you locate and open a 2D image in the Image Viewport.

- **Import**: Lets you import a 3D model into the open Bunkspeed Shot project. For details, see Importing Models.

- **Export**: Lets you export the open project to any of the following formats:
  - Autodesk FBX
  - OBJ

- **Save Project**: Saves your current Bunkspeed Shot project in native BIF format, overwriting the same location and filename as the original.

- **Save Project As**: Saves your current Bunkspeed Shot project file in BIF format, using the arbitrary file name and location that you specify.

- **Close**: Closes the current project and leaves Bunkspeed Shot running.

- **Exit**: Exits Bunkspeed Shot.

Edit Menu

The Edit Menu provides the following standard options:

- **Undo**
- **Redo**
- **Cut**
- **Copy**
- **Paste**
- **Delete**
- **Select All**
- **Deselect All**
- **Find**
View Menu

The View Menu provides the following options:

- **Model Mode**: Activates Model Mode and displays the contents of the Model Tab in the Palette.
- **Material Mode**: Activates Material Mode and displays the Material Tab in the Palette.
- **Scene Mode**: Activates Scene Mode and displays the contents of the Scenes Tab in the Palette.
- **Camera Mode**: Activates Camera Mode and displays the contents of the Cameras Tab in the Palette.
- **Library Mode**: Activates Library Mode and displays the contents of the Library Tab in the Palette.
- **Show HUD**: Toggles visibility of the heads-up display, which shows some or all of the following data (depending on the current mode):
  - **Total Frame Count**: This number grows until you stop the session.
  - **Progress**: Provides an approximation of the rendering progress.
  - **Frames per Second**: Tells you the average framerate (passes), which are iterations on the final image that progressively get more refined and less noisy.
  - **Resolution**: The resolution (i.e. in pixels, width by height) of the 3D Viewport as well as output Snapshots.
  - **Polygon Count**: Number of actively used polygons in the project.
  - **Focal Length**: The focal length (in millimeters) of the virtual lens for the camera used for the rendering.
  - **GPU Only, CPU Only, or Hybrid** indicates the current rendering mode.
- **Build All Thumbnails**: Generates thumbnail images of materials, models, and similar elements in the Palette.
- **Pause Rendering**: Stops a rendering in progress.
- **Enable Raytracer**: Toggles real-time raytracing in the 3D Viewport.
- **Show Camera Panel**: Toggles visibility of the Camera Toolbar.
- **Show Palette**: Toggles visibility of the Palette.
- **Enter Full Screen**: Maximizes the Bunkspeed Shot window and hides the Main Menu. Press F11 to return to the windowed mode.
Project Menu

The *Project Menu* provides the following options:

![Project Menu](image)

**MODEL**

- **Show All**: Reveals all models and parts that may have been hidden.
- **Import Model**: Lets you locate and open a 3D model to import into the open Bunkspeed Shot project. For details, see Importing Models.
- **Create Model**: Creates the standard geometric shape (e.g. sphere, cube, cylinder, etc) that you choose from the drop-down list.

**MATERIAL**

- **New Material**: Creates a new material in the open project, and opens the Material Tab in the Palette so you can customize the new material.
ENVIRONMENT

- **New HDR Environment**: Brings up a file loader so you can locate and open a high dynamic range image to provide environmental lighting in your scene.
- **Decrease Brightness**: Decreases the brightness of the loaded HDR environment image.
- **Increase Brightness**: Increases the brightness of the loaded HDR environment image.

BACKPLATE

- **New Backplate**: Lets you locate and open a standard 2D image for the backplate behind your scene.

CAMERA

- **New Camera**: Creates a new camera at the default position, and switches the 3D Viewport to show the view from the new camera.
- **Next**: Switches the view in the 3D Viewport to the next camera in the list of existing cameras.
- **Previous**: Switches the view in the 3D Viewport to the previous camera in the list of existing cameras.
- **Reset**: Repositions the current camera to the world origin.
- **Lock**: Prevents the current camera from being moved.
- **Save to File**: Saves the current camera to a file, so the camera can be shared with other projects and users.

PROJECT

- **New Model Set**: Creates a new model set, which can contain multiple models in the same scene.
Tools Menu

The **Tools Menu** provides the following options:

- **Screenshot**: Takes a quick snapshot of your current Bunkspeed Shot scene, exactly as it appears in the 3D Viewport, and saves the screenshot in the Images Library.

- **Render**: Starts rendering your scene at the resolution specified in the Options Dialog. When completed, the rendering will be saved in the Images Library.

- **Unify all Identical**:
  - **Materials**: Eliminates duplicate materials in your local Bunkspeed Content \ Materials folder.
  - **Textures**: Eliminates duplicate textures in your local Bunkspeed Content \ Textures folder.

- **Convert HyperShot Material Library**: Causes Bunkspeed Shot to convert materials from earlier versions of Bunkspeed Shot (formerly called HyperShot) to the latest version of Bunkspeed Shot material files, and then places the converted materials in the default Material Library. Doing this can take time (up to 30 minutes), and is relevant only to those who used HyperShot to create custom materials that they have need for in Bunkspeed Shot.

- **Deactivate License**: If you wish to switch licenses (e.g. from a node-locked license to a floating license), or transfer a license from one machine to another, use this option to deactivate your old license first. Then exit and restart Shot. When the Licensing Setup screen appears, select the desired licensing option.

- **Login to Bunkspeed**: Displays the login screen, so you can log into a remote Bunkspeed library. For details, see [Web Libraries](#).

- **Options**: Displays the [Options Dialog](#) described in detail below.
OPTIONS DIALOG
The Options Dialog can be displayed by selecting Options from the Tools Menu, or pressing Ctrl-K. The Options Dialog includes the General, 3D Viewport, and User Interface Tabs. For details, see the sub-sections below.

General Tab

- **Default Project**: Determines the path to the project file that Bunkspeed Shot opens by default when you fire it up. The provided *Default Project.bif* is empty except for a basic HDR image in the environment to provide lighting.
  - To change the default project to the open project, LEFT-CLICK the Use Current Project as Default button.

- **Library Paths**: To change the folders containing any library, LEFT-CLICK the Browse button to the right of the target library, and navigate to the new folder for that library.
  - **Environments**: Path to the folder containing the HDR images in the Environments Library.
  - **Materials**: Path to the folder containing the materials in the Materials Library.
  - **Images**: Path to the folder containing saved screenshots and renderings.
  - **Models**: Path to the folder containing the models in the Model Library.
  - **Plates**: Path to the folder containing the images in the Plates Library.
  - **Projects**: Path to the folder containing the Bunkspeed Shot projects in the Projects Library.
  - **Textures**: Path to the folder containing the images in the Textures Library.
  - **Cameras**: Path to the folder containing the cameras in the Cameras Library.

- **Reset All Settings**: Restores all options to their factory defaults.

3D Viewport Tab

- **Realtime Options**:
  - **Auto Pause**: If enabled, Bunkspeed Shot pauses realtime raytracing when the application loses focus. When it regains focus, then the raytrace picks up from where it left off.
  - **Default to Raytrace**: If enabled, Bunkspeed Shot starts with raytracing on. (Note: Turning on raytracing during real-time editing might result in slower responses.)
  - **Image Filtering**: Image filtering is a new technique which reduces the noise of pixels in the rendering. It turns on a noise reduction technique for the first 50 passes of calculation, and then turns it off. At 100 passes an actual image filter is then applied to completely remove noise. Enabling this option slows down the calculation rate of each pass, but still speeds up the appearance of a complete image!
  - **Maximum Resolution**: The resolution (i.e. in pixels, width by height) of the 3D Viewport as well as output Snapshots.
• Display Options:
  – **World Axis**: Toggles visibility of the world XYZ-axes. (This option is available only when raytracing is turned off.)
  – **Model Bounding Boxes**: Toggles visibility of bounding boxes around models. (Available only when raytracing is turned off.)
  – **Parts Bounding Boxes**: Toggles visibility of bounding boxes around parts in models. (Available only when raytracing is turned off.)
  – **Show Selection Outline**: Toggles visibility of the highlight that appears around active selections. The highlight is useful for showing visually what is currently selected.

**User Interface Tab**

• Interface Options:
  – **Enable Tooltips**: Toggles visibility of short instructions which appear when you mouse over a button or control.
  – **Automatically Update Thumbnails**: If enabled, Bunkspeed Shot updates all the thumbnails that appear everywhere in the Palette.
  – **Automatically Play Movies**: If enabled, this option automatically plays movies when the "create movie" checkbox is checked when you render an animation. It will open and play the animation in whichever media player is associated with the extension that you output the movie at.

• Timeline Options:
  – **Default Keyframe Tangent Rule In**: Enable to set the default style of keyframe upon creation.
  – **Default Keyframe Tangent Rule Out**: Same as above.

**Import Tab**

• Auto-Paint Options:
  – **Autopaint**: When enabled, Autopaint builds an association between the names you give parts/materials/layers in your CAD package, and the names of Bunkspeed Shot materials you assign to those parts after import. Based on your paint/naming pattern, Shot learns how to Autopaint a model upon import.
    » Example: Suppose in CAD you always name a tire layer "Tires," and in Bunkspeed Shot you always paint the part called "Tires" with the Black Rubber material. As a result, every time you import a model that has a part called "Tires," Shot will automatically assign the Black Rubber material to that part. This feature essentially lets you pre-paint your model in the CAD package, so you don't have to assign materials once that file is imported.
  – **Enable Auto-Paint by Default**: Activates the auto-paint feature each time the program is run.
  – **Enable Auto-Paint Data Storage**: Activates a persistent list of the associations you make during usage.
  – **Maximum Auto-Paint Storage**: Lets you determine how big the Data Storage list can get.
  – **Reset Auto-Paint Data**: Clears your Data Storage list and lets you start over.
• **Auto-Size Options:** Lets you set the rules for the size objects should be scaled to when they are "auto-sized" upon import.
  – **Minimum Size Limit:** Sets the smallest that a part should be if it initially imports far too large.
  – **Maximum Size Limit:** Sets the largest that a part should be if it initially imports far too small.
  – **Scale Using Powers-Of-Ten:** Applies a power of ten multiplier to either increase or decrease the size of the original model when it is auto-sized.

**Raster Tab**

• **Quality Options:**
  – **Anti-Aliasing Level** controls the process of softening the unnaturally precise or stepped edges (sometimes known as 'the jaggies') that are created when a computer-generated object is placed against a contrasting background. This softening process is accomplished by using pixels of intermediate shades as a buffer between the object and its background. The higher the value of **Anti-Aliasing Level**, the better the step removal, but the more impact the performance. The available settings will vary based on your video card.
  – **Shadow Quality** determines the smoothness of the ground shadow and self-shadows.
  – **Shadow Resolution** determines the pixel dimensions for the map created for the shadow projections.
  – **Environment Resolution** determines the pixel dimensions used to clamp the HDR environment image.
  – **Gloss Resolution** determines the pixel dimensions that the reflection map is calculated at, so as to determine the material gloss levels.

• **Performance Options:**
  – **Enable Performance Mode:** Activates a drawing mode wherein all shaders are simplified significantly, so as to dramatically increase the speed of realtime editing. It is useful for models that are very large or have lots of textures – and for ensuring animations play back consistently at 30 FPS. Even if this mode is enabled, the final image will still be rendered with the original shaders.
Help Menu

The Help Menu provides the following options:

- **Contents (F1)**: Opens the Bunkspeed Shot User Guide you are reading.
- **About**: Displays the version number of your copy of Shot.
- **System Info**: Provides an estimate of Shot's performance on your PC hardware, and suggests upgrades when needed.

Progress Bar

The Progress Bar appears on the far right of the Main Menu, above the Palette, whenever Shot is doing tasks that take substantial time to complete.

**VIEWPORTS**

A Viewport dominates most of the area in the Bunkspeed Shot window. Bunkspeed Shot provides you with a 3D Viewport, plus additional tabs that appear when you open images in the Image Viewport, as explained below.

3D Viewport

The 3D Viewport shows the open project with the currently selected camera. When you move the camera around the scene, or change any content, the 3D Viewport updates in real-time.

Image Viewport

The Image Viewport displays the images in the Image Library. Since screenshots and renders are saved to the Images Library by default, the Image Viewport is a convenient way to look over your output images.

Rendering Viewport

The Rendering Viewport displays the currently rendering image, when applicable.

Login System

Bunkspeed Shot provides a convenient means for you to download content for use in your projects. By copying shared content from Bunkspeed's servers to your local hard drive, you can quickly build a vast local library of materials, HDR environment images, models, backplate images, and more! For details on usage, see “Web Libraries” on page 38.
TOOLBAR

The Main Toolbar provides selectors for most tools other than the camera. The Camera Toolbar provides controls for the current camera.

Main Toolbar

The Toolbar appears near the top of the 3D Viewport, by default. The Toolbar provides you with shortcuts to some of all of the following functionality depending on which version of software you have:

Raytrace On, Off, Blend

Lets you choose between three real-time rendering modes: Raster for quick but limited lighting; Raytrace for slower but maximum quality lighting; and Blend for some of both:

Blend is the new default mode. When in Blend mode, the scene automatically switches to Raster mode when any interaction is performed – such as moving the camera, moving the model, playing an animation, dragging a material, etc. As soon as the operation is finished and the mouse stops moving, the raytraced version of the scene then gets blended over the raster version.

Selection Tools

Lets you choose what will be selected when you left-click an object, or part of an object:

- **Model**: When enabled, LEFT-CLICK a model to select it.
- **Part**: When enabled, LEFT-CLICK a specific part in a model to select just that part.
- **Group**: When enabled, LEFT-CLICK a specific part in a model to select the group containing that part.
- **Material**: When enabled, LEFT-CLICK a material on a model to select the material and display its properties in the Material Tab of the Palette.

Object Manipulation Tools

Brings up the Transform Manipulator to visually Move, Scale, or Pivot (i.e. rotating) the selected model or material, as illustrated below.
### Move

- If the Selector Tool is in Model Mode: Activating the Move Transform Tool displays the Transform Manipulator for visually Transforming Models, as well as the Model Tab for numerically transforming models. (By “transforming” we mean moving in 3D, as well as rotating around all 3 axes.) Note:
  - Right-clicking and dragging the center yellow square of the Move manipulator "sticks" the selected object onto any other object you drag it over. This feature is useful for placing object on a table for instance. It uses the selected objects’ pivot point as its "base," so moving the pivot to the bottom of the bounding box is recommended.

- If the Selector Tool is in Material Mode: Activating the Move Transform Tool displays the Texture Manipulator for visually Mapping Textures onto parts in models, as well as the Material Tab for numerically mapping textures.

### Scale

The Scale Transform Tool works the same as the Move Transform Tool (above), except it scales instead of moving or rotating.

### Pivot

The Pivot Transform Tool works the same as the Move Transform Tool (above), except it acts on only the pivot point of the selected object.

### Absolute Mode

If Absolute is enabled, model transformations are relative to world space. If disabled, model transformations are relative to local model space. (Absolute Mode is not applicable to materials.)

### CAMERA CONTROL

Select the Camera Control Tool to set the camera’s behavior from the following options (left to right in the screen shot). For details, see “The Camera” on page 40.

- Rotate
- Pan
- Zoom
- Twist
- Look At
RAY BRUSH
The Ray Brush lets you to select a circular area within which raytracing happens, and outside of which raytracing does not happen. For details, see “The Ray Brush” on page 71.

For example, if you've painted an entire vehicle, but care most about the headlights, you can refine just the headlights as follows:

1. Hover the Ray Brush over the headlight. When you're making material adjustments, they will update only within the Ray Brush bounds – and will happen much faster because no effort is spend resolving the rest of the image.

2. When you are ready, turn off the Ray Brush and the remainder of the image will resolve uniformly to match the area refined in the Ray Brush.

RENDER BUTTON
Click the Render button to display the Render Options dialog, or click an option in the drop-down menu that appears while the mouse hovers over this button. (Note: Renderings and snapshots are saved in the Images Library, by default.)

Camera Toolbar
The Camera Toolbar and related properties are in a floating panel with a free-floating panel that provides controls to quickly switch between front, back, far side, near side and top and bottom cameras.

- **Perspective Selector**: (Note that pressing the Revert button returns your camera to the state it was in prior to using any of the following arrows.)
  - Click the *left side* of the Perspective Selector to display the open scene from the left;
  - Click the *right side* of the Perspective Selector to display the open scene from the right;
  - Click the *top* of the Perspective Selector to display the open scene from the front;
  - Click the *bottom* of the Perspective Selector to display the open scene from the back;
  - Click the *center* of the Perspective Selector to display the open scene from overhead.

- **Drop-Down Menu**: Select any preset camera from the drop-down menu to display the scene in the 3D Viewport using that camera.

- (+) creates a new camera preset

- (lock icon) locks / unlocks the current camera

- Click “Camera” to open the camera’s properties.
PALETTE

The Palette contains various tabs corresponding to the following modes:

- Model Tab
- Material Tab
- Scenes Tab
- Cameras Tab
- Library Tab
- Color Picker

You can undock the Palette and move it around the screen separately from the main Shot Window, and then re-dock it later if desired. To undock the Palette, LEFT-CLICK-HOLD the top bar of the Palette, and drag it away from its dock. To re-dock the Palette, drag-and-drop it the same way onto the arrow on the far right side of the main Shot window, where it is normally docked.
Model Tab

The Model Tab provides you with the following options for selecting and transforming models and their parts:

MODEL TREE

The names of the Models in your scene, and the parts within each Model, appear in the Model Tree near the top of the Model Tab in the Palette.

- Select the Model Set containing the models you want in your scene.
- To select a Model and display its parameters in the Model Tab:
  – Option 1: Click the target model in the Model Tree of the Model Tab.
  – Option 2: Set the Selection Tool (in the Toolbar) to Model Mode, and click the target model in the scene.
- To select a Part and display its parameters in the Model Tab:
  – Option 1: Click the target Part in the Model Tree of the Model Tab.
  – Option 2: Set the Selection Tool (in the Toolbar) to Part Mode, and click the target part in the scene.

When a Model is selected, it is outlined in yellow.

When a Part is selected, it is outlined in blue.
MODEL / PART PARAMETERS
Select a model or part to display and optionally modify its parameters (see figure on previous page). Note that parts have some parameters that whole models do not, and they share some parameters as well. The following lists all available parameters regardless of the user’s current selection:

- **Import Model**: Click to import a model into the current scene.
- **Name**: Type over the name of the selected object to change it.
- **Hide**: Toggles the visibility of the selected object in the 3D Viewport. (Note: Emissive shaders still emit light into a scene even when their parts are hidden.)
- **Faded**: Hides a model from the camera’s view, but leaves it in the scene in terms of lighting.
- **Symmetry**: Mirrors the selected object across the specified axis. This is useful for symmetric object because you can import just half the object (have the number of triangles) and instance their symmetric data.
- **Rotate (X+90, Y+90, Z+90)**: LEFT-CLICK one of these buttons to rotate the selected object by 90-degrees around the selected axis.
- **Flip**: Reverses the orientation of the object around the selected axis.
- **Pivot Center**:
  - **Model**: Moves the pivot point of the selected model to the center of the bounding box of the model.
  - **Environment**: Moves the pivot point of the selected model to the center of the environment.
- **Snap to Ground**: Moves the object so it rests on the ground.
- **Center**: Moves the object to the center of the XZ-plane.
- **Auto Size**: Automatically sizes the object to best fit within the environment, and locates the object at the world origin.
- **Reset**: Moves the object to the location it was first imported into the open project, and returns it to its scale upon initial import.
- **Transform**: Provides the following parameters for numerically moving, rotating, and scaling of the selected object.
- **Rasterization Options**:
  - **Enable Ground Shadows**: Toggles ground shadows on/off in Performance Mode only (i.e. with Raytracing turned off). Has no effect in Raytrace Mode.
- **Part/Normals Control**: Edits and rebuild the normal vectors on the selected part. For details, see “Part/Normals Control” on page 51.
- **Texture Mapping**: Controls how textures are mapped onto the selected part. For details, see “Texture Mapping on Parts” on page 52.
Material Tab

The Material Tab provides you with the options discussed in this section. When you select a material on a model, the material is highlighted in orange.

**MATERIAL TREE**

Each and every material in the open project is listed in the Material Tree near the top of the Material Tab. Display options: tiles, thumbnails, or text lists.

1. To select a material and display its parameters, LEFT-CLICK its name or icon in the Material Tree (see image to the left).
2. To apply a material to part in a model in the 3D Viewport, DRAG-AND-DROP the material from the Material Tree to the target part.

**MATERIAL PARAMETERS**

When you select a specific material in the Material Tree (or select a material on a part in a model), the parameters defining the material appear in the Material Tab of the Palette. Exactly which parameters appear and depends on the type of the selected material (e.g. glass, metal, leather, etc). Different parameter values for the same type of material produce variations within the type (e.g. silver verses gold).

You cannot create new types of materials, but you can edit the values of material parameters to create unique variations within each type.

All materials in Bunkspeed Shot share the following parameters:

- **Material Name**: An arbitrary name for the material. You can optionally overwrite the default name.

- **Material Type**: The type (i.e. category) of material – such as glass, metallic paint and plastic. Different types of materials have different parameters that appear here. For a list of all types of materials supported by Bunkspeed Shot, with details on the parameters for each type, see “Types of Materials in Bunkspeed Shot” on page 77.

- **Texture**: Expand to display Texture Parameters.

- **Texture Mapping**: Expand to display parameters for texture mapping, as explained in “Texture Mapping on Parts” on page 52.

**Save Material**

- **To Library**: Saves the selected material to the Material Library using the Bunkspeed Material File format. This action makes the material readily available to other Shot projects on the same PC.

- **To File**: Saves the selected material to an arbitrarily folder using the Bunkspeed Material File format. This action makes it easy to share materials with other Shot users.

- **Reset Material**: Resets the material to the state it was in before you started making edits to it.
TEXTURE PARAMETERS
Expanding the Texture parameters near the bottom of the Material Tab allows you to add Color, Specular, Alpha, and Bump textures to the selected material. (For usage instructions, see Add and Edit Texture Materials.)

After you load a texture for a material, you can tune its parameters. When you apply a material with one or more textures to an object, Bunkspeed Shot maps the textures onto the selected parts in the target object.

- **Sync Textures:** Once you fill in the values for one type of mapping, select this option to copy those values to the other types of mapping (assuming the other types have loaded textures).

- **Color, Specular, Alpha, or Bump:** Allows you to load a texture of the selected type: Color, Specular, Alpha, or Bump. (This option appears only if you have not already loaded a texture of this type.)

The following parameters appear after you load a color, specular, alpha, or bump texture to the selected material:

- **Enable Texture:** Turns on/off the a texture that has already been loaded. (This option appears only if a texture of the selected type has already been loaded.)

- **Tile (U, V):** The default of (1, 1) causes exactly one copy of the texture to be mapped, from edge to edge, across each target part. Values greater than “1” cause tiles of the texture to repeat across each part. For example, a value of (2, 2) causes the texture to repeat twice along each axis, forming a 2x2 grid of tiles across the surface of each host part.

- **Shift (U, V):** Offsets the center of the texture in horizontal (U) and vertical (V) directions, relative to the normalized texture coordinates on the host part. The default of (0,0) centers the texture on the part.

- **Repeat (U, V):** Toggles between single and multiple copies of the texture. per axis.

- **Blend Texture:** (Color and Specular textures only) Combines the loaded image with the color of the material itself in an additive fashion that allows you to tint textures.

- **Rotation:** Rotates the texture in texture space on the target surface.

- **Bump Scale:** (Bump textures only) Determines the height of the bumps. Negative values give the impression of engraving.

- **Invert Bump:** (Bump textures only) When inverted, hills in the bump texture become valleys, and valleys become hills.

- **Treat as Normal Map:** (Bump textures only) When you first add a bump or normal texture, Shot makes an educated guess about which type it is (indicated by the half-checked box for this parameter). When using actual normal maps, you can manually select Normal Maps by fully checking this box. Otherwise, use Treat as Normal Map to toggle between Bump Mapping and Normal Mapping, and select whichever produces the best results.
• **Treat Bumps as Displacement:** Converts the highlights and shadows in the greyscale bump texture to actual 3D displacement. This adds realism by adding actual physical depth to the bump texture!
  – Technical Note: When making the conversion from 2D to 3D, Shot re-tessellates the underlying geometry to add 2 triangles to every pixel on the texture mapped to that geometry. For high detail textures, you will need a lot of RAM or vRAM.

• **Remove Texture:** Removes the texture of the selected type (i.e. if Specular is selected, this button removes the Specular texture).

### Scenes Tab

The Scenes Tab provides you with options for applying and managing environmental lighting via HDR images, and adding back plate images as well.

#### SCENE TREE

Every HDR environment image loaded into the open project is listed near the top of the Scene Tree in the Scenes Tab. Backplates are listed in the Scene Tree below loaded environment images. These image lists can take the form of tiles, thumbnails, or text.

1. To select an environment or backplate image and display its parameters, LEFT-CLICK its entry in the Scene Tree.
2. To switch to different environment or backplate image in the open project, DOUBLE-LEFT-CLICK its entry in the Scene Tree.
   – Alternative: Drag-and-Drop the entry in the Scene Tree into the 3D Viewport.

#### HDR ENVIRONMENT PARAMETERS

When you select an HDR environment image in the Scene Tree, Bunkspeed Shot displays the following parameters Scenes Tab. You can edit these parameters to tune the selected image.

• **Show Environment Image:** Toggles visibility of the environment image loaded in the 3D Viewport. Even when invisible, the loaded environment image still emits light into the scene.

• **Flatten Ground:** When enabled, the environment becomes a half-sphere. When disabled, the environment becomes a full sphere.

• **Background Color:** Determines the background color of the 3D Viewport outside the environment sphere. LEFT-CLICK the color to display a standard color picker.

• **Brightness:** Adjusts the overall brightness of the selected environment image.

• **Gamma:** Indirectly adjusts the contrast of the selected environment image.

• **Size:** Determines the radius, in meters, of the environment sphere.
• **Height**: Shifts the loaded environment image vertically (up and down) on the environment sphere.

• **Rotation**: Rotates the loaded environment image on the environment sphere.

• **Flip Horizontal**: Flips the environment image horizontally (left / right) around a vertical axis in the center of the image.

• **Ground Reflection**: Adjust the visibility of the ground reflection where 0 is off and 1 is full reflection.

• **Ground Glossiness**: Adjusts the roughness of the ground reflection where 0 is perfectly crisp and 0.5 is fully rough.

• **Ground Shadow**: Toggles the projection of shadows on the ground in both Performance and Raytrace Modes.

• **Show Grid**: Toggles visibility of a grid in the XZ-plane. (The grid is visible only when Raytrace is off.)

• **Create New Backplate**: Lets you import a new 2D backplate image, which can be in any supported file format. Backplate Parameters are listed below.

### BACKPLATE PARAMETERS

When you select a previously loaded backplate image in the Scene Tree, then the following parameters appear:

• **Visible**: Toggles the visibility of the loaded backplate image.

• **Resolution**: (read-only) Displays the pixel width and height of the selected backplate image.

• **Fill Background**: Stretches the backplate to fit within the aspect ratio set on the camera.

• **Auto-Fit Camera**: 

• **New HDR Environment**: Lets you import a new HDR environment image

### CONTEXT-SENSITIVE SCENE MENU

Right-click in the upper area of the Scene Tab to display a context-sensitive menu that includes the following options for creating new scene elements:

– New HDR Environment
– New Sun and Sky Environment
– New Backplate
– New Light
Cameras Tab

The Cameras Tab provides you with options for creating, configuring, managing, and using various cameras to view and record your scene.

**CAMERA TREE**

Each camera in the open project is listed near the top of the Camera Tab. The Camera Tree can take the form of tiles, thumbnails, or text lists.

1. To select a camera for editing, LEFT-CLICK its name or icon in the Camera Tree.

2. To switch to different camera in the open project, DOUBLE-LEFT-CLICK its name or icon in the Camera Tree. DRAG-AND DROP works too.

**CAMERA PARAMETERS**

- **Camera Name**: An arbitrary name you can give a camera.
- **Locked**: When enabled, you cannot move the selected camera.
- **Aspect Ratio**: Sets the aspect ratio of the rendered area within the 3D Viewport. Type over these values to change them.
- **Distance / Dolly**: Determines the distance between the selected camera and the look-at point. You can also dolly / zoom the camera in several other ways, as explained in Zoom the Camera.
- **Azimuth**: Rotates the selected camera around the look-at point. You can also rotate the camera in several other ways, as explained in Rotate the Camera.
- **Incline**: Moves the selected camera vertically.
- **Twist**: Tilts the selected camera left/right without moving its 3D position. You can twist cameras in other ways, as explained in Twist the Camera.
- **Perspective**: Controls the amount of perspective distortion in the selected camera by changing the focal length of its virtual lens. Smaller perspective values reduce perspective distortion, and increases the focal length of the lens. Larger values do the opposite.
- **Focal Length (mm)**: Controls the amount of perspective distortion in the selected camera according to an accurate simulation of optical physics in camera lenses. Although the 3D position of the camera remains unchanged, smaller values provide a wider angle of view and therefore seem to move the camera further away. Larger values do the opposite.
- **Orthographic View**: Toggles between perspective and orthographic cameras. When enabled, all perspective distortion is eliminated, regardless of the values of Perspective and Focal Length.
- **Keep Above Ground**: When enabled, you cannot move the camera below the ground in the open project. When disabled, you can move the camera anywhere.
Depth of Field
Depth of Field is the rate that blur increases for objects further from the focal plane. Controls:
- **Enable Depth of Field**: Toggles the calculation of depth of field.
- **Focal Distance**: The distance between the camera and the point of optimal focus.
- **Aperture (mm)**: Uses millimeter to set the diameter of the opening in virtual lens of the selected camera.
- **F-Stop**: Uses F/stop to set the diameter of the opening in virtual lens of the selected camera.

**ShotRule of Thirds Overlay**
This feature toggles an overlay of a **Thirds Ruler** or **Quarters Ruler** to aid with composition when using this camera. You can configure the **Grid Line Color** to your preference.

**MISCELLANEOUS**
- **Reset Camera**: Resets the camera to the factory defaults.
- **Save Camera File**: Saves the selected camera to the Cameras Library, using the Bunkspeed Camera File format. You thereby have the option to load this camera in a separate project, and share the camera with other Shot users.

**Library Tab**
By default, the Library Tab provides you with the means to import and manage files in your local libraries (see list below).
- Camera Library
- Environments Library
- Image Library
- Materials Library
- Models Library
- Plates Library
- Project Library
- Texture Library
- Web Libraries

- If you are logged on, you can choose between the Local library in the Bunkspeed Content folder on your hard drive, and **Web Libraries** on Bunkspeed’s servers, by clicking their respective buttons near the top of the Library Tab. Local and web libraries use the same names by default, but they are totally separate. By copying items from the to your Local library, you can add to your local collection. To prevent copying the same item more than once, items in the Web library that you already have a copy of are tagged with a green check.

- In the Palette, near the top of the Library Tab is a search option and a triangle. If you LEFT-CLICK the triangle, something like Windows Explorer will appear so you can create sub-folders and organize your items in your local libraries. These sub-folders will be created under
Bunkspeed Content folders on your hard drive. For example, you can create new sub-folders in the Material folder, so you can organize your materials however works best for you.

- A list of the items in a library occupies the entire lower space of the Library Tab.

- You can change the default folders for the Libraries in two ways:
  - Either edit the paths in the General Tab of the Options Dialog;
  - or drag new folder from Windows Explorer into the target libraries in the Library Tab of the Palette (one library at a time).

**CAMERA LIBRARY**

The Camera Library contains images in the Bunkspeed Content \ Cameras folder, by default.

1. To load a library camera into the open project, DRAG-AND-DROP it from the Camera Library into the 3D Viewport. Once loaded, the camera will be saved with the project (i.e. added to the list of cameras in the Cameras Tab of the Palette), and become independent of the Camera Library.

**ENVIRONMENTS LIBRARY**

The Environments Library contains high dynamic range images in the Bunkspeed Content \ Environments folder, by default.

1. To apply the image to the environment of the open scene, DRAG-AND-DROP an HDR image file from the Environments Library to the 3D Viewport. Once applied, the HDR image will be saved with the project (i.e. added to the list of HDR images in the Environments Tab of the Palette), and become independent of the Environments Library.

**IMAGE LIBRARY**

The Images Library contains images in the Bunkspeed Content \ Images folder, by default. The Images Library is where Shot saves screenshots and renderings.

1. DOUBLE-CLICK an image in the Image Library to display a larger view of the image in the Image Viewport.

**MATERIALS LIBRARY**

The Materials Library contains the material files in the Bunkspeed Content \ Materials folder, by default.

1. To apply the material to a part on a model, DRAG-AND-DROP the material from the Materials Library to the target part in the 3D Viewport. Once applied, the material will be saved with the project (i.e. added to the list of materials in the Material Tab of the Palette), and become independent of the Materials Library.
MODELS LIBRARY
The Objects Library contains the model files in the Bunkspeed Content \ Models folder, by default.

1. To add the model to the open scene, DRAG-AND-DROP the target model file from the Objects Library into the 3D Viewport. Once added, the model will be saved with the project (i.e. added to the list of models in the Model Tab of the Palette), and become independent of the Model Library.

PLATES LIBRARY
The Plates Library contains the backplate images in the Bunkspeed Content \ Plates folder, by default.

1. To apply an image to the backplate of the open project, DRAG-AND-DROP the target image from the Plates Library into the 3D Viewport. Once applied, the image will be saved with the project (i.e. added to the list of images in the Scenes Tab of the Palette), and become independent of the Plates Library.

PROJECT LIBRARY
The Project Library contains the project files in the Bunkspeed Content \ Projects folder, by default.

– To load a project in Bunkspeed Shot, DRAG-AND-DROP a project file from the Project Library to the 3D Viewport.

TEXTURE LIBRARY
The Textures Library contains the images in the Bunkspeed Content \ Textures folder, by default. These images are intended for use as textures in materials.

WEB LIBRARIES
After you log in, the Local and Web buttons appear in the upper right of the Library Tab in the Palette. Use these buttons to switch between your Local library and the Bunkspeed web library.

Here’s how you log into the Bunkspeed web library:

1. Select the login prompt in the upper right corner of the Bunkspeed Shot window, and the Login to Bunkspeed screen will appear.
2. In the *Login to Bunkspeed* screen, enter the **email address** and **password** you used to obtain a license to Bunkspeed Shot. If you are using a trial version, you can click **Register** to create an account to the Bunkspeed library.

![Login to Bunkspeed](image)

**Color Picker**

The Color Palette is available in various Tabs and several dialog boxes.

You can select the Color Palette from wherever a color parameter appears. For example, when you select a material in the Material Tab, its Color parameters appear as strips of color. Clicking any of these Color parameters displays the Color Palette for editing that color.

![Color Picker](image)

The Color Picker has all the standard controls, plus an eyedropper that lets you sample colors anywhere on your screen – even outside the Bunkspeed Shot window!
CONTEXT SENSITIVE MENU

For convenience, Bunkspeed Shot provides a context sensitive drop-down menu that appears when you RIGHT-CLICK various things in the user interface. The options in the Context Sensitive Menu change according to the active tool, your selection, and other circumstances.

The Context Sensitive Menu provides quick access to commonly tools that can be invoked in other ways, as explained elsewhere in this Guide. In most cases, the Context Sensitive Menu does not provide you with any unique options; it just makes some common options more accessible.

THE CAMERA

This section describes how to use the camera in Bunkspeed Shot. Controls for the current camera are in the free-floating Camera Toolbar (below).

Automatic Perspectives
Use Perspective Selector on the far left side of the Camera Toolbar (see figure above) to switch between front, back, far side, near side and top and bottom cameras with a single click:

- Click the left side of the Perspective Selector to display the open scene from the left.
- Click the right side of the Perspective Selector to display the open scene from the right.
- Click the top of the Perspective Selector to display the open scene from the front.
- Click the bottom of the Perspective Selector to display the open scene from the back.
- Click the center of the Perspective Selector to display the open scene from overhead.
Basic Camera Movements

Using the Camera Selector in the Main Toolbar (see figure above), you can Rotate the Camera, Pan the Camera, and Zoom the Camera relative to its look-at point (i.e. the point in the scene that the camera is focused on). You can also Change the Look At Point, and Save a Camera to a File, among other things.

By default, the camera is restricted to moving above ground. To let the camera move below the ground, de-select Keep Above Ground in the Camera Tab of the Palette.

**Rotate the Camera**

This option rotates the camera around the selected look-at point:

1. To rotate the camera around the look-at point, HOLD both the **Alt-Key** and **LEFT MOUSE BUTTON**, and then **DRAG the MOUSE**.
   - Alternative: **LEFT-CLICK** the Camera Selector in the Toolbar, and select the **Rotate** icon (see figure). Then **LEFT-CLICK-HOLD** and **DRAG the MOUSE** without holding the **Alt-Key**.

**Pan the Camera**

Panning the camera moves it left/right and up/down in the current viewing plane. The camera keeps pointing in the same direction, and the look-at point moves with the camera.

1. To pan the camera, HOLD both the **Alt-Key** and **MIDDLE mouse button**, and **DRAG the MOUSE**.
   - Alternative: **LEFT-CLICK** the Camera Selector in the Toolbar, and select the **Pan** option (see figure). Then **LEFT-CLICK-HOLD** and **DRAG the MOUSE** without holding the **Alt-Key**.

**Zoom the Camera**

Zooming the camera moves the camera closer to or further away from the object, while pointing in the same direction. (Technically this is a “dolly” camera, but the term “zoom” is more widely understood.)

1. To zoom the camera, HOLD both the **Alt-Key** and **RIGHT mouse button**, and **DRAG the MOUSE**.
   - Alternative 2: **LEFT-CLICK** the Camera Selector in the Toolbar, and select the **Zoom** option (see figure). Then **LEFT-CLICK-HOLD** and **DRAG the MOUSE** without holding the **Alt-Key**.
   - Alternative 2: Change the **Distance/Dolly** parameter in the Camera Tab of the Palette.

**Twist the Camera**

Twisting the camera rotates it clockwise / counterclockwise in the 2D plane of the screen:

1. To do a 2D twist around the center of the 3D Viewport, select the **Twist** option from the drop-down Camera Control in the Toolbar (see figure), and **DRAG THE MOUSE** without holding down the **Alt-Key**.
   - Alternative: Change the **Twist** parameter in the Camera Tab.
Change the Look At Point
The Look-at point acts like a pivot point for the Rotate and Zoom methods of moving the camera.

1. To set a new look-at point, LEFT-CLICK the Camera Selector in the Camera Bar, and select the Look-At option. Then LEFT-CLICK the desired location of the new look-at point in the 3D Viewport. The camera will move to center the new look-at point. Notes:
   - Panning the camera moves the look-at point with the camera.
   - To change the perspective of the camera, hold down the Alt-key while using the scroll wheel.

Additional Camera Controls

Reset the Camera
Resetting a camera restores its position and the look-at point to the World Origin, and sets the focal length and other camera parameters to their default values.

1. To reset the active camera, press the Reset Camera button in the Camera Tab of the Palette.

Lock / Unlock

1. To prevent the current camera from moving, select the Locked button in the Camera Tab of the Palette.
   - Alternative: Select the desired camera in the Camera drop-down list in the Toolbar, and toggle the Lock icon next to the list.

Use Camera Presets
Making a camera preset allows you to return later to the exact position and settings of the current camera.

1. To preset the current camera, LEFT-CLICK the plus (+) next to the Camera drop-down menu in the Toolbar.
2. To return to any recorded Preset, select the desired Preset from the Camera drop-down menu in the Toolbar.

Save a Camera to a File
The current settings and position of the active camera can be saved to a file, which makes it easy to share cameras with other Shot projects and other users.

1. To save the active camera to a file, LEFT-CLICK the Save Camera File button in the Camera Tab of the Palette. Shot saves the camera to the Camera Library, by default.
Chapter 4: Working with 3D Models

You can load multiple 3D models into your Bunkspeed Shot project. (In this document, models, objects, and meshes are all the same thing: 3D geometry that's defined in a computer file.) Coordinates within a model are in model space (i.e. relative the model's origin), and coordinates in a Bunkspeed Shot project are in project space (i.e. relative to origin in the center of the scene). The separation of model space and project space helps Bunkspeed Shot preserve the correct relative sizes of multiple models in the same Bunkspeed Shot project.

IMPORTING MODELS

Bunkspeed Shot can import 3D models in many common file formats. Most 3D modeling software today can export to at least one of the formats that Bunkspeed Shot can import. (For a complete list of supported import formats, see “Import Formats for 3D Models”.) Support for some of these 3D formats depends on plugins that you can download for free from Bunkspeed’s web site:

http://www.bunkspeed.com

Importing a model is easy:

1. To import a model, select File > Import from the Main Menu. The Import Settings dialog appears, so you can locate and load a model.
   – Alternative: Select Project > Import Model from the Main Menu.
   – Alternative: In the Model Tab of the Palette, RIGHT-CLICK in the Model Tree, and select Import from the Context Sensitive menu.

2. The Import Settings dialog (below) may contain format-specific import options. If the dialog appears, select the import options you prefer and LEFT-CLICK OK to import the model:

   – Geometry (see figure on previous page):
     » Ignore Invisible Geometry: If geometry in the source model is set as invisible, then Shot ignores that geometry upon import.
     » Automatically Resize Geometry: Automatically sizes the model upon import to best fit within the environment of the open project.
Part Grouping: Divides geometry into parts based on your choice of groups, materials, and/or divisions in the source model. The Default option (generally recommended) uses all three to produce the most diverse divisions.

Tessellation Quality: determines the relative accuracy of the results when converting a model to polygons. The higher the tessellation quality, the more polygons are used to represent curved surfaces in the model, and the smoother the results. The downside to high quality tessellation is a heavy model with a large file size that’s more taxing on your hardware.

Advanced Tessellation Settings: Lets you fine-tune exactly how models get tessellated (i.e. converted into polygons). Experts only.

Advanced Sewing Settings: Specifying multiple passes ensures that parts in models are all connected (i.e. they all share vertices), so as to eliminate seams between adjacent materials.

Materials:
- Ignore Texture References: ignore all textures associated with materials in the source model.
- Auto Search for Missing Textures: look in logical places for missing textures referenced by materials in the source model.
- Texture Auto-Search Paths: Lets you specify where Shot looks for textures referenced by materials in the source model.

Importing OBJ Files

When exporting the OBJ file from your source software, make sure to choose a tessellation that meets your needs. Close-ups in Bunkspeed Shot look best at higher tessellation (i.e. more triangles for smoother surfaces) than more distant views. You must determine tessellation inside the 3D modeling software you are using to create the model. You can’t change the tessellation of a model after it’s been imported into Bunkspeed Shot.

Fine tessellation increases the size of an OBJ file, so ensure that your computer has enough RAM and other resources to handle your preferred degree of tessellation.

The OBJ file format does not support a full scene graph, but it does maintain all material assignments, including textures. When importing an OBJ file and its material files, make sure that all associated files stay together in the same folder. Upon import of the OBJ file, Bunkspeed Shot will automatically copy the model’s textures into the Textures Library.

All materials inside the OBJ file are converted to material groupings in Bunkspeed Shot. Specifically, all parts in your model sharing the same material will become a single material group in Bunkspeed Shot. You cannot alter imported material groups from within Bunkspeed Shot. Hence, you must assign materials in your 3D modeling software before exporting to OBJ.

Bunkspeed Shot interprets imported material files – as well as any texture maps, bump maps, or decals that are used in the model. After importing the model, Bunkspeed Shot allows you to edit the resulting material parameters in the usual way, or by assigning other materials from the Material Library.
Importing SolidWorks Files
Bunkspeed Shot allows you to directly import SolidWorks 2011 and prior files (SLDPRT and SLDASM).

Bunkspeed Shot uses the tessellated information stored with the SolidWorks part files. In most cases, this tessellation is fine enough for good results in Bunkspeed Shot, but close-ups may require finer tessellation. Please refer to your SolidWorks documentation for information about refining the tessellation of your part file and/or entire assembly. Refining tessellation can significantly increase file size, as can importing larger assemblies. Make sure that your computer has enough RAM and other resources to handle large files. Importing and rendering larger files may affect system performance.

When importing a single part file, Bunkspeed Shot uses the materials that were inside SolidWorks in order to determine the material groups. Bunkspeed Shot places identical materials into a single material group. Objects with no assigned materials will use a single material group.

When importing an assembly file, Bunkspeed Shot assigns an individual material group to every part in the assembly, as well as any material that is contained within the individual parts. Identical parts will be grouped into a single material group.

Upon import, Bunkspeed Shot interprets any materials described in the SolidWorks file, including texture and bump maps that have been applied in SolidWorks. Bunkspeed Shot stores all necessary information in a BIF (Bunkspeed Interactive Format) file.

Importing Pro/ENGINEER and CREO Files
Bunkspeed Shot support a Pro/E plugin which allows you to launch your model directly from Pro/E into Shot. You can get the plugin on Bunkspeed’s web site.

Importing Rhino Files
Before importing Rhino files (3DM format, version 5 or earlier), make sure that your individual parts and material groups are on individual layers in Rhino. Bunkspeed Shot converts individual layers to different material groups. In addition, you will need to assign material to all objects by layer.

Importing SketchUp Files
When importing SketchUp files (SKP format, version 8 or prior), Bunkspeed Shot takes the geometry and color information, along with all applied textures, and brings them into Bunkspeed Shot. All textures are kept in a separate folder together with the original SketchUp file in the original location.
Importing IGES Files
When importing IGES files, Bunkspeed Shot recognizes any layer information inside the IGES file. These layers result from layer information in the original CAD file, or the assembly structure. Each layer is imported as an individual material group. Original materials are not recognized.

Importing STEP Files
Bunkspeed Shot recognizes assembly information inside imported STEP files. All parts inside the assembly result in individual material groups. Original materials are not recognized.

Importing WIRE Files
Shot can import WIRE files automatically – provided you have an Autodesk Alias product installed from 2008 - 2011.

TRANSFORMING MODELS
There are several ways you can transform (i.e. move, rotate, and/or scale) 3D models in the open Bunkspeed Shot project:

• Numerical Transforms
• Using the Transform Manipulator

All transforms are relative to pivot point of the model. (The pivot point of the model is determined by the external modeling software used to create the model.) In the drop-down menu of the Transform Manipulator,

– if you select Absolute Mode, transforms are relative to a copy of the world axis at the pivot point of the model;
– if you de-select Absolute Mode, transforms are relative to the model's local axis and pivot point.
Numerical Transforms

Numerical transforms allow precise translation, rotation, and scaling of a model. You control numerical transforms with the Model Tree and Transform parameters in the Model Tab of the Palette. (The Model Tree lists all the models in the open project, and the parts in each model.)

1. In the Model Tab of the Palette, LEFT-CLICK the name of the target model in the Model Tree to select the model. Be sure to select the entire model, not just one part or just the root node.
   – Alternative: Select the Model Selector in the Toolbar, and then DOUBLE-CLICK the target model in the 3D Viewport.

2. In the Transform section of the Model Tab, you can modify the position, rotation, and scale of the selected model as follows:
   – **Position XYZ:** changing these values causes the model to move along the selected axis (from left to right: X, Y, Z). For example, entering “5” in the X-field causes the model to move 5 units along X-axis of the project’s coordinate system.
   – **Rotation XYZ:** changing these values causes the model to rotate around the selected axis (from left to right: X, Y, Z). For example, entering “90” in the Y-field causes the model to rotate 90-degrees around the Y-axis of the project’s coordinate system.
   – **Scale XYZ:** changing these values unequally distorts the model (i.e. entering different values in the (X, Y, Z) fields scales the model by a different amount along each axis).
   – **Scale All:** changing this value to something other than “1” causes the model to grow or shrink proportionally. For example “2” will double the size of the model, and “0.5” will half its size.

For a comparison of numerical and visual transforms, see the table in the next section.
Using the Transform Manipulator

You can transform a model visually with the Transform Manipulator. Visual transforms are quick and easy, but not as precise as numerical transforms.

1. Active the Model Selector Tool in the Toolbar, and select the target model in the 3D Viewport. (You can’t transform individual parts separately from their parent model.)

2. Activate the Object Manipulation Tool in the Toolbar, and select the **Move Manipulator** to translate the model, or the **Scale Manipulator** to scale the model, or the **Pivot Manipulator** to rotate the model relative to its root node. The Transform Manipulator matching your selection appears in the 3D Viewport. To use it, follow the instructions in the table below:

### Numerical vs. Visual Transforms

<table>
<thead>
<tr>
<th>Action</th>
<th>Numerical Transforms from the Model Tab in the Palette</th>
<th>Visual Transforms with the Transform Manipulator</th>
</tr>
</thead>
</table>
| Move the model          | **POSITION XYZ**: Moves the model along the selected axis (X, Y, or Z) by the distance you specify. | Select the **Move Manipulator**. Then LEFT-CLICK-HOLD the desired axis and drag the mouse to move the model:  
  • Red Line: Moves along X-axis  
  • Green Line: Moves along Y-axis  
  • Blue Line: Moves along Z-axis  
  • Yellow Box: Free form moves |
| Pivot the model         | **ROTATION XYZ**: Rotates model around the selected axis (X, Y, or Z) in degrees. | Select the **Pivot Manipulator**. Then LEFT-CLICK-HOLD the ring around the desired axis, and drag the mouse to rotate the model around that axis:  
  • Red Ring: Rotates around X-axis  
  • Green Ring: Rotates around Y-axis  
  • Blue Ring: Rotates around Z-axis |
| Scale the model         | **SCALE XYZ**: Scales the model along each axis individually (X, Y, or Z), which distorts the model.  
  **SCALE ALL**: Scales the model uniformly.  
  The units are relative to 1 = current size. For example, “2” makes your model twice as large as it currently is. | Select the **Scale Manipulator**. Then LEFT-CLICK-HOLD the desired axis and drag the mouse to scale the model:  
  • Red Line: Scale in the X-axis  
  • Green Line: Scales in the Y-axis  
  • Blue Line: Scales in the Z-axis  
  • Yellow Box: Scales uniformly |
<p>| Set the model on the ground | <strong>SNAP TO GROUND</strong>: Moves the model in the vertical axis, until the model’s origin is vertically aligned with the world origin. | n/a |
| Reset all transforms to their values when you last saved the project | <strong>RESET</strong>: Resets all transforms made since you last saved the project. | n/a |
| Rotate model 90 degrees | <strong>ROTATE</strong>: Rotates model exactly 90 degrees around the selected axis (X+90, Y+90, Z+90) | Move: Hold the Shift-Key while dragging a ring to rotate the model in 15-degree increments. |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip the model</td>
<td><strong>Flip</strong>: Mirror the model across the selected axis (X, Y, Z) n/a</td>
</tr>
<tr>
<td>Attach one model to another</td>
<td>n/a Move: RIGHT-CLICK-HOLD the Yellow Box and drag the mouse to move the selected model onto another model. The pivot points of the two models will stick together.</td>
</tr>
</tbody>
</table>

**MOVE MANIPULATOR**

![Move Manipulator Diagram]

**SCALE MANIPULATOR**

![Scale Manipulator Diagram]
HIDING / SHOWING MODELS AND PARTS

If your source model has parts defined in it, then Bunkspeed Shot will preserve these parts when you import the model. In Shot, you can selectively hide and show individual parts on the models in your project. Hiding parts selectively is very useful when applying materials to layered objects and isolating parts for individual renderings. Here’s how:

- To show / hide models or parts: In the Model Tab in the Palette, select the target model or part in the Model Tree, and toggle the Hide check box. Alternatives using the context-sensitive menu (see figure):
  - To hide a model, use the Model Selection Tool to RIGHT-CLICK the target model in the 3D Viewport, and then select Hide Model from the context sensitive menu.
  - To show all models and parts in the loaded project, RIGHT-CLICK anywhere in the 3D Viewport and select Show Everything from the context sensitive menu.
  - To show selected parts only, RIGHT-CLICK anywhere in the 3D Viewport and select Show Parts from the context sensitive menu.
MORE ABOUT PARTS

When a material with a texture is mapped to a specific part, some of the mapping properties are inherited from the definition of the material. You can further refine the mapping of the material onto a part you have actively selected in a model. You can also modify the normals in the part, and control Symmetry. Here’s how:

Symmetry
Symmetry mirrors the selected part across the specified axis. This is useful for symmetric objects because you can import just half the model (have the number of triangles) and instance their symmetric data.

Part/Normals Control
Part and normals control reconstructs normals. This process often solves flipped normals as well as badly formed normals common in Sketchup files and lesser quality data.

- **Part/Normals Control:**
  - **Faceted:** Rebuilds normals with hard edges between the polygons
    - **Angle:** Lets you choose how sharp of an edge to maintain
  - **Smooth:** Rebuilds the normals with a blended joint between polygons, yielding a softer surface description
  - **Rebuild Normals:** Executes the rebuild process.
  - **Repair Normals:** Aligns normals without rebuilding the texture verts.
  - **Split Part:** See Splitting Models and Parts, next.
  - **Extract Part:** See Splitting Models and Parts, next.

Splitting Models and Parts
A "part" is a grouping of one or more pieces in a model. Each piece is also a part which can be composed of still smaller pieces, etc. Pieces don’t have to be physically next to each other to be grouped together.

Here’s how you split parts into smaller pieces:

1. Right-click a part in the open scene using the Selection Tool. (Alternately, In the Models Tab of the Palette, click the thumbnail of the target part to select it.)
2. In the right-click menu, select **Extract Part**. The Part Splitting dialog appears. (Alternately, you can select **Extract Part** from the Model Tab.)
3. In the Part Splitting dialog, adjust the tolerance of part splitting via the Facet Angle Tolerance setting and the slider next to it. To preview the tolerance settings, left-click the target part and continue the adjustments.

4. When ready to execute the split, right-click the target part again.

**Texture Mapping on Parts**

The Model Tab in the Palette includes the following Texture Mapping parameters, which appear when you actively select a part in the open model:

- **Mode**: Determines how the selected texture is projected onto 3D surfaces. Each of the following types of texture mapping includes its own parameters for controlling the mapping. (For illustrations, see Texture Mapping on Parts using the Texture Manipulator.)
  - **UV**: If your object does not have UV coordinates, its textures may not show up initially. Fix by changing projection type.
  - **Box**: Uses a “box” projection.
  - **Planar (X, Y, Z)**: Projects a flat texture plane in the X, Y or Z-axis. To determine the direction, turn on the coordinate system in the Image Tab, or use [SHIFT] + C. If the surface you would like to map to is at an angle, you may want to rotate the model so it aligns with the direction of the projection. After mapping, move the object back to its original position, and the mapping will move with it.
  - **Spherical**: Uses a spherical projection with Y being the up-axis. If your object requires spherical mapping in a different direction, rotate the object to align with the projection direction. Move the object back to its original position after mapping.
  - **Radial**: Projects the texture as a circular plane, like a circular version of Planar.
  - **Cylindrical**: Projects the texture as a cylinder standing up (y-direction) for mapping. If your object requires cylindrical mapping in any other direction, rotate the object to align with the projection direction. Move the object back to its original position after mapping.
  - **Perspective**: Maps the texture from the current camera angle so that it maps perfectly, but ONLY from the current camera.

- **Manipulate Texture**: Lets you visually shift, scale, and rotate the selected texture on an applied surface using the Texture Manipulator, which is a type of Transform Manipulator that acts on textures in materials. For details, see Texture Mapping on Parts using the Texture Manipulator.

- **Fit to Part**: Sizes the texture projection to the bounding box of the selected part. This option typically yields the best quick fit, and gives you a good starting point to continue editing the placement of the texture.

- **Set to World Scale**: Sets the texture scale to world coordinates so that when that particular texture is applied to multiple parts and each part is set to World Scale, then the texture pattern becomes a consistent size on each one of those parts. It will also update on each part when the texture properties such as a tiling, repeat and rotation is changed.

- **Transform**: Lets you numerically modify the texture mapping on the selected part. The alternative is Texture Mapping on Parts using the Texture Manipulator, as discussed in Manipulate Texture above.
**TEXTURE MAPPING ON PARTS USING THE TEXTURE MANIPULATOR**

The Texture Manipulator modifies the 3D projection of a texture in a material, prior to the texture being converted to (U, V) coordinates on the surface of the part the material is applied to. This approach is quite different than using Texture Parameters such as Tile, Shift, and Rotation to adjust texture mapping, because the latter parameters act in (U, V) space after the projection has been applied to the surface of the target part.

The Texture Manipulator functions much like the Transform Manipulator. The obvious difference is that the Texture Manipulator operates on textures in materials, and the Transform Manipulator operates on models.

Another key difference is that the Texture Manipulator combines the Move and Scale Transform Manipulator into a single control. Translation and rotation operate the same for both controls, but the scale operates differently on the Texture Manipulator control.

The following instructions apply only to parts that have mapped materials using textures:

1. Enable the Texture Manipulator, which you can do in 2 ways:
   - Use the Selector Tool in Material Mode to select a part in a model. It’s parameters will then appear in the Model Tab of the Palette. Then, under Texture Mapping, select the **Manipulate Texture** button.
   - In the Toolbar: If the Selector Tool is in Material Mode, activating the Move Transform Tool displays the Texture Manipulator.

2. To scale with the Texture Manipulator, simply LEFT-CLICK-HOLD one of the boxes at the corners of the manipulator, and drag the mouse.

3. To translate and rotate with the Texture Manipulator, follow the instructions for Using the Transform Manipulator – bearing in mind that translation and rotation will affect the texture projection on a part instead of the model itself.
Also of note are minor changes to the Texture Manipulator depending on the projection mode you are using. Here are all variations (note that UV projection mode does not have a corresponding texture manipulator, but all other 3D projection modes do):

**Box**

**Cylinder**

**Sphere**

**Planar X**

**Planar Z**

**Radial**

---

**DELETING MODELS AND PARTS**

You can delete individual parts from a 3D model, or delete the entire model. The part or model is not permanently deleted until you save the Bunkspeed Shot project.

- To delete a model: In the Model Tree of the Model Tab in the Palette, RIGHT-CLICK the *name* of the target model, and select *Delete* from the context sensitive menu.
  - Alternative: Using the **Model Selector** in the Toolbar, select the target model in the 3D Viewport, and press the DELETE-KEY.

- To delete a part in a model: In the Model Tree of the Model Tab in the Palette, RIGHT-CLICK the *name* of the part, and select *Delete* from the context sensitive menu.
  - Alternative: Using the **Part Selector** in the Toolbar, select the target part in the 3D Viewport, and press the DELETE-KEY.
Chapter 5: Working with Materials

Bunkspeed Shot comes with a library of pre-defined materials that you can apply to 3D models in your Bunkspeed Shot projects. You can also create new materials quite easily. This chapter describes how to work with materials.

For details on the types of materials that come with Bunkspeed Shot, and the properties of each type, see “Types of Materials in Bunkspeed Shot” on page 77.

DISPLAY THE MATERIAL LIBRARY

To display the Material Library (shown to the left), select the Library Tab in the Palette, and then select Materials from the drop-down menu near the top of the Library Tab.

APPLY MATERIALS

You can add an existing material to the open project in two ways: apply a material in the Material Library to a model; and load a material from a model into the Material Tab (i.e. into the project). Once a material is part of the open project, you can then Apply Materials to Parts in Models.

- A “part” is a subset of a model. A complex car model could have thousands of parts, for example: Each of the 4 wheels could be a separate part, and each wheel part could be composed of smaller parts for the metal rim, rubber tire, lock nuts, and brake rotors.
- You cannot define parts in Bunkspeed Shot. Parts are defined in the 3D modeling software used to create the original model. When you import a model with parts into Bunkspeed Shot, the parts will be preserved.
- A material in the open project is totally independent from the materials in the Material Library:
  - The materials in the open project are saved in the BIF file with the rest of the assets in the project (e.g. models, HDR images, backplates, cameras, etc.)
  - The materials in the Material Library are the files in the Bunkspeed Content\Materials folder, by default.
When you apply XYZ material in the Material Library to a model / part in the open project, Shot adds the XYZ material to the project. If you then edit the XYZ material in the project, via the parameters in the Material Tab of the Palette, then the copy of the material in the project will be affected, but the source material in the Material Library will be unaffected. The reason is that materials in the project and those in the Material Library are totally independent of each other (even if they have the same names and parameter values).

When you open a project containing materials that are not in your Material Library, then the new materials will appear in the Material Tab of the Palette. To add such a material to your Material Library, simply select the target material in the Material Tab, and LEFT-CLICK Save Material To Library.

Apply Materials to Parts in Models

The process in this case varies slightly depending on whether your source the material from the Material Library or the materials already in the open project, as explained below.

**USE A MATERIAL IN THE MATERIAL LIBRARY**

To apply a material in the Material Library to a part of a 3D model, do the following:

1. Display The Material Library.
2. DRAG-AND-DROP the desired material from the Material Library onto the target part of the 3D model.

**USE A MATERIAL IN THE OPEN PROJECT**

To apply a material that’s already in the open project to a part on a model, do the following:

1. LEFT-CLICK the Material Tab in the Palette to activate Material Mode and access a list of materials in the open project.
2. DRAG-AND-DROP the desired material from the Material Tab (not the Material Library in the Library Tab) onto the target part of the 3D model.
CREATING, EDITING, AND SHARING MATERIALS

Bunkspeed Shot’s materials are fundamentally different than shaders found in traditional rendering applications. All the materials in Bunkspeed Shot are scientifically accurate. It therefore requires far less guesswork to create or edit a Bunkspeed Shot material to have the properties you’re after.

When you create or modify materials, the changes are saved in the BIF file for the open project, and the new or modified materials are listed in the Material Tab of the Palette. Creating or editing a material in the Material Tab does not add the material to the Material Library. To add such a new or modified material to your Material Library, simply select the target material in the Material Tab, and LEFT-CLICK the Save Material To Library button.

Create and Edit Materials

Creating a new material, and editing an existing material, are nearly identical procedures:

1. To create a new material, RIGHT-CLICK in the Material Tree of the Material Tab in the Palette, and select New Material from the context sensitive menu.

1. Or, to edit an existing material, LEFT-CLICK the desired material in the Material Tree to select the material, and then change the values of its parameters.

Note: If you first apply the new or modified material to a model in the open scene, then you can more clearly see the visual effects of changes to the material’s parameters. To do so, DRAG-AND-DROP the target material from the Material Tab to a part in a model in the open project.

2. In the Material Tab of the Palette, ensure that the target material is selected, and then change the Material Type parameter, if necessary, by selecting the target type from the drop-down menu.
– Each type of material has unique parameters. You can change the values of these parameters, but you cannot change which parameters are available except by switching to a different type. Hence, you should first decide upon the target type of the new or edited material before changing any of its parameters.
– For details on the types of materials that Bunkspeed Shot supports, and the parameters of each type, see “Types of Materials in Bunkspeed Shot” on page 77.

3. In the Material Tab, you can edit the values of the Material Parameters for the selected material, as desired.

4. Also in the Material Tab, you can optionally assign textures to your materials, as described in the next section.

5. Once you finish editing a material, you can optionally add it to the Material Library, as follows:
   i. Select the target material in the Material Tab of the Palette, and LEFT-CLICK the Save Material To Library button.
Regardless of whether or not the material originated in the Material Library, saving it from the Material Tab to the Material Library adds the modified material to the Library as though it were a totally new material.

Add and Edit Textures in Materials

You can optionally use almost any 2D image as a texture that can be added to a material. When a material with textures is applied to a part of a model, Shot maps the textures on the part according to the properties of the textures. Here’s how:

1. In the Material Tab, select the target material in the Material Tree.

2. LEFT-CLICK the Color, Specular, Alpha, or Bump channels in the Material Tab to display the Import Textures dialog. (See the figure to the left.)
   - **ALTERNATIVE:** Drag-and-Drop a 2D image from your desktop, email, or similar source, to the target Part of a model in the open scene. Then select which channel to apply the texture to (e.g. Color, etc).
   - With Color textures, non-transparent materials can use a 2D texture instead of a base color. However, Some types of materials, such as Emissive, multiply the base color by the Color texture RGB values.
   - If you are adding an Alpha texture with transparency, Bunkspeed Shot uses the transparency channel in the Color texture only.

3. In the Import Texture dialog, locate and select the target texture.
   - Note: You can use any 2D image in a supported format such as JPEG or TIFF, among others. However, if your texture contains transparency, you must use a format such as PNG that supports an alpha channel.
   - For a list of supported texture formats, see “Import Formats for Backplates and Textures” on page 77.

4. After a texture has been added to a material, you can display most of its parameters in the Material Tab by selecting the icon of the material in the Material Tree; or by using the Material Selector Tool to select a part that the material has been applied to.
   - Note: You can control how the texture is applied to a specific part in a model by selecting that part. For instructions, see “Texture Mapping on Parts” on page 52.

5. In the Material Tab, when you select a texture in a material, you an edit its parameters as discussed in Material Tab.

Mapping Textures

If you select an applied material on a part in a model, and the material includes textures, then you can customize its texture mapping in these ways:

- Visually with the Texture Manipulator, as explained in **Texture Mapping on Parts using the Texture Manipulator**;
- Numerically using basic UV mapping, as explained in “Texture Parameters” on page 32;
- Numerically using more advanced types of mapping, as discussed in “Texture Mapping on Parts” on page 52.
Share Your Materials

It's easy to share your materials with others. Bunkspeed Shot saves the materials in your Material Library in BMF files. These BMF files are located in the Materials Library, which is contained in the Bunkspeed Content > Materials folder by default.

1. To share materials with others, just give them copies of the BMF files in your Material Library. BMF files can be emailed.

When the recipients save your BMF file into their local Material Library folder, they will be ready to use your materials in their next Bunkspeed Shot session.

DECALING

Decals are materials with a texture that includes a transparency channel, so it shows through whatever is under it. Decals are commonly used to put logos on top of other materials, for example.

Creating Decals

The texture that you load for a decal should use a transparency channel to define the areas in the decal that should be transparent:

1. To create a decal, right-click a new blank material in the tree of the Material Tab, and select New Decal from the context-sensitive menu (see figure).

2. In the file browser that appears, locate and load a decal texture.
Editing Decals

To edit the properties of a loaded decal, select the decal icon in the tree of the Material Tab (see figure), and tune its properties:

- **Decal Name** lets you rename the decal if you wish.
- **Multiple Part Decal** allows the decal to span multiple parts of the model.
- **Detached Decal** removes the association of the decal from all parts, and lets you move it by itself.
- **Decal Depth** defines how deep beyond the surface the decal penetrates.
- **Show Decal Texture** toggles whether the image represented on the decal is shown or overwritten by white to use as a stencil.
- **Use Brightness as Opacity** causes any dark portions of the decal to be transparent. The closer to black the pixels, the more transparent that area of the decal becomes.
- **Decal Width** lets you determine the physical width of the Decal in meters.
- **Decal Height** lets you determine the physical height of the Decal in meters.
- **Project from Current Ortho Camera** lets you project the decal from the active camera, provided the active camera is an Orthographic camera.
Chapter 6: Working with Scenes

In Bunkspeed Shot, you use High Dynamic Range Images (HDR) as the light source for your projects. How? Bunkspeed Shot maps an HDR image of your choice onto a spherical environment that envelops your models like a giant bubble. The HDR image thereby radiates light into the scene according to the RGB values of each and every pixel in the image. This technique closely simulates real world lighting, even when wide contrast ranges are called for.

When you right-click in the tree near the top of the Scene Tab, options appear for loading new HDR images, lights, and backplates.

For details, see the following sections:

• Create and Edit HDR Environment Images
• Create and Edit Backplate Images
CREATE AND EDIT HDR ENVIRONMENT IMAGES

A single High Dynamic Range Image (HDR) provides realistic lighting for projects created in Bunkspeed Shot. For instructions, see Load a HDR Environment Image, next.

Load a HDR Environment Image

Loading a new HDR image into an environment replaces the old HDR image. Once loading completes, you will see the lighting in your scene change to use the light from the new HDR image.

1. Select Project > New HDR Environment from the Main Menu.
2. In the Open Environment dialog, navigate to the desired HDR file and open it. The HDR image loads into the environment of your scene.
   • Alternative: To apply a previously loaded HDR image to your project, DOUBLE-LEFT-CLICK the icon of the desired image in the Scenes Tab.
   • Alternative: In the Scenes Tab of the Palette, RIGHT-CLICK within the Environment Tree near the top (which lists the environments saved with your project), and select New HDR Environment.

TUNE HDR ENVIRONMENT IMAGES

Upon import, Bunkspeed Shot preserves the brightness and gamma settings in the source HDR file. After import, you can change these settings, as well as make other adjustments to the environment, in the Environments Tab of the Palette.

To display all the tools, left-click the Tools button in the Quick Start bar, or left-click the expansion bar on the far right edge of the Bunkspeed Shot Window. Then select the Scenes Tab to display Environment Tools.

Show / Hide the Environment

To toggle the visibility of the environment image, LEFT-CLICK the Show Environment Image check box in the Scenes Tab of the Palette when the target Environment icon is selected therein. Notes:

• Even when hiding an HDR environment image from direct view, the image continues to radiate light into the project as well as reflect visibly off shiny surfaces.
• When an environment image is hidden, and a backplate (if any) is also hidden, the color of the background is defined by the Background Color parameter in the Scenes Tab.
**Transform the Environment**

By default, the HDR image used in a Bunkspeed Shot environment is mapped onto a sphere with a radius of 25 meters centered at the world origin. The sphere envelops your entire project with HDR light that very closely simulates the light in real world environments. You can rotate, scale, and offset the environmental sphere, relative to the world origin. See the subsections below for details.

**Rotate the Environment**

To rotate the environment, and thereby change the direction of light radiated by the environment image, edit the Rotation parameter in the Scenes Tab of the Palette. Rotation is in degrees.

**Scale the Environment**

To make the environmental sphere whatever radius you wish, within reason, change the Size (meters) parameter in the Scenes Tab of the Palette.

**Offset the Environment**

To vertically offset the environment image relative to the world origin, edit the Height (meters) parameter in the Scenes Tab.

**Adjust Brightness and Gamma**

You can adjust the brightness and gamma of the light emitted by the environment image in your project. For details, see the sections below.

**Environmental Brightness and Gamma**

Modifying the brightness of the environment image changes the exposure of the image. (Note: Bunkspeed Shot changes brightness and contrast in real-time. The source file of the environment image is not altered.)

Changing the exposure of the environment image alters the luminance (i.e. intensity) of the light the image radiates into your open project. (Note: Everything except backplates images are affected by the light emitted from the applied HDR environment image.)

Modifying the gamma of an environment image changes contrast indirectly. Altering gamma also change brightness, but in a very different way than the Brightness parameter. Although gamma is not the same as contrast, you can use gamma to adjust contrast, while using brightness to adjust luminance. Used together, these two controls enable you to fine tune the combined brightness and contrast of the lighting in your project.

Because HDR images have so much data (32-bits per channel of RGB data), they have a very wide contrast range. Hence, small changes to the brightness and contrast of an HDR image usually produces high quality results.

1. Display the **Environments Tab** in the Palette.

2. In the Environments Tab, change the **Brightness** parameter and observe the results in the Realtime View. Higher values increase brightness; lower values decrease it.
3. Change **Gamma** in the Environments Tab, and observe the results in the Realtime View. Higher values decrease contrast and increase brightness; lower values increase contrast and decrease brightness.

**Display Shadows**

Bunkspeed Shot can calculate the shadows that each 3D model casts on itself, on other models, and on the ground. Enabling shadows can impact performance due to the increased number of calculations required.

1. To enable or disable ground shadows, toggle on the **Ground Shadow** parameter in the Scenes Tab of the Palette.

**Flatten the Ground**

HDR images are spherical by default, with the equator corresponding to the imaginary level of the ground. Flattening the ground converts the environment sphere to a half-sphere. The image is re-mapped to the resulting half-sphere, and the bottom becomes a visible ground.

- To flatten the ground of an environmental sphere, toggle on the **Flatten Ground** parameter in the Environments Tab.
CREATE AND EDIT BACKPLATE IMAGES

A backplate allows you to load a high resolution 2D image in the background of your Bunkspeed Shot project. Once loaded, the backplate image always remains in the background no matter where you move the camera.

3D models in the scene retain the lighting specified by a HDR environment image, without influence from the backplate image. Backplate images do not emit light in your scene, do not cast shadows, and do not reflect in shiny surfaces. They just look great in your background.

Load Backplate Images

To load a new backplate image into your Bunkspeed Shot project, or replace the current backplate image, do the following:

1. Select Project > New Backplate from the Main Menu. The Open Background Plate dialog appears.

2. In the Open Background Plate dialog, navigate to the image you wish to import and open it. The image loads into the background of the open project, and stays in the background regardless of camera movements.
   - Alternative 1: Place your background images into the Plates Library. Then DOUBLE-LEFT-CLICK the desired image in the Plates Library to apply the image to your open project.
   - Alternative 2: In the Scenes Tab of the Palette, RIGHT-CLICK anywhere in the Scene Tree near the top, and select New Backplate.
   - Note: The Auto-Fit Camera parameter in the Scenes Tab automatically fits the camera to the backplate, while matching the aspect ratio of the active camera to that of the backplate.

Loading a new image into the background of your scene replaces the old backplate image, if any. Backplate images do not affect the lighting in your scene.

To show or hide a loaded backplate image, first select it in the Scenes Tree in the Scenes Tab of the Palette. When its parameters appear, toggle the Visible parameter to show or hide the backplate image.
Chapter 7: Saving and Outputting

SAVING

In Bunkspeed Shot, whenever you use File > Save Project to save a file, Bunkspeed Shot saves the open project in the Projects Library, in its native BIF format. The BIF format packages all assets associated with the project into a single file.

When you select File > Save Project As, Bunkspeed Shot gives you the choice of saving the BIF file to a different folder.

Bunkspeed Shot can open BIF files created in earlier versions of Shot and Move. However, once you save the project in Bunkspeed Shot, you cannot open it again in earlier versions.

OUTPUTTING IMAGES

Bunkspeed Shot can output images of your projects in the following ways:

- **Snapshot (High Speed)** quickly captures what you see on your screen with a lot more user control than an ordinary screen shot.

- **Render (High Quality)** invokes raytracing at the quality and other custom settings that you specify. Several rendering modes are available.

- **Render (Animations)** renders a movie of the animations you have set up in the open scene.

- **The Ray Brush** provides a means of rendering some areas within a scene more accurately than others, without the processing time required to render the entire scene more accurately.
Snapshot (High Speed)
Taking a Snapshot is like taking a screen shot, but with more options.

**TAKE A SNAPSHOT**
Taking a Snapshot of an open Bunkspeed Shot project uses the current camera to capture what you see in the 3D Viewport. Here’s how:

*Configure Snapshots*
You must do the following things before you take Snapshots:

1. Press **CTRL-K** to display the Options dialog. In the 3D Viewport Tab of that dialog, set the **Maximum Resolution** to the desired size (in pixels) of Snapshots.

*Take a Shot*

2. Click the **Render Button** located in the right corner of the Toolbar. In the Render Options dialog that then appears, choose the **Snapshot** tab.

3. In the Snapshot tab of the Render Options dialog:
   - **Image Format**: Select the desired output format from the following options:
     » Jpeg (jpg)
     » Bitmap (bmp)
     » Tiff (tif)
     » Photoshop (psd)
   - **Save Camera File**: If enabled, then Shot will save the camera you used to take the snapshot along with the snapshot itself. The camera file will be saved in the Cameras Library, and the snapshot will be saved in the Images Library.

4. Click **Take Snapshot** to finish, or Save and Close to save the current position and composition for later reference.
Render (High Quality)

Bunkspeed Shot can generate high quality renderings that are incredibly realistic, but it can take some time depending on your hardware, the complexity of your Bunkspeed Shot project, and the resolution of the render.

Here’s how you make a high quality rendering of the scene that’s open in Bunkspeed Shot:

1. Click the **Render Button** located in the right corner of the Toolbar (or select **Tools > Render** from the Main Menu).
2. In the Render Options dialog that appears, choose **Render** from the tabs.
3. In the Render Options (described below), select the **Render Options** that you prefer.
4. LEFT-CLICK **Start Render** to start the rendering process. The HUD will show the progress. When completed, Shot will save the rendering in the Bunkspeed Content \ Images Library by default.

**Render Options**

All or some of the following Render Options are available, depending on the Output Mode and other choices you make in the Render Options dialog:

**Output File**

- **Filename**: Give the file to be output a filename.
- **Image Format**: Select the format of the output file from the list. (Note: The HDR format preserves 32-bit per channel RGB data.)
- **Output Mode**: Select from the following output modes:
  - **Render**: Renders a single image using the current camera.
  - **All Cameras**: Renders a single image using each and every camera in the open scene – producing the same number of renderings as you have cameras in the scene.
- **Render Output Passes**

  - **Include Alpha**: If enabled, the output file includes an alpha channel.
Resolution

- **Resolution**: The number of pixels (width by height) in the output file.
- **Print Resolution**: The pixels per inch in the output file.
- **Print Size**: The printed size of the output file, given its **Resolution** and **Print Resolution**.
- **Print Units**: Selects between inches and centimeters for **Print Size**.
- **Backplate**: Uses the same resolution as the loaded backplate image.

Render Settings

- **Render Mode**: Gives you the following options for rendering:
  - **Time Limit**: Stops the rendering after reaching the time limit you enter here, regardless of the final quality. After the render starts, you can optionally stop it early.
  - **Quality**: Stops the rendering after reaching the number of rendering passes you enter here, regardless of time.

Miscellaneous

- **Send to Queue**: If enabled, the current rendering will be added to a queue, so you can do it later. The default of "Local" renders the scene with your local PC. If you have both Powerboost and Move Pro installed, select "Powerboost" here to render the scene using remote servers.
- **Render in Background**: Causes Shot to render “in the background,” so Shot uses less memory. Users of 32-bit operating systems should consider selecting this option – particularly with high res renders.
- **Boost Rendering**: Lets you leverage other PCs on the same network to assist with rendering.
- **Show Viewport**: If enabled, Shot updates the real-time view in the 3D Viewport to show the rendering as it happens.
- **Render Using**: Select CPU to use your CPU exclusively (good for users with a basic graphics card); select GPU to use your graphics card exclusively (good for users with a powerful graphics card); select Hybrid to use both your CPU and GPU.
Render (Animations)

The rendering of animations is controlled with the following options:

- Animation Options
- Render Options

**ANIMATION OPTIONS**

The following options control the animation sequences:

**Output File**

- **Filename**: Give the file to be output a filename.
- **Image Format**: Select the format of the output images.
- **Render Output Passes**

- **Movie Format**: Sets the format of the output movie.
- **Include Alpha**: If enabled, the output file includes an alpha channel.

**Animation**

- **Create Movie**: If enabled, Shot encodes the animation data into a movie format using the parameters below:
- **Start Frame**: Sets the first frame to render in the animation sequence.
- **End Frame**: Sets the last frame to render in the animation sequence.
- **Start Time**: Sets the time the animation begins, relative to the zero keyframe.
- **End Time**: Sets the time the animation ends, relative to the zero keyframe.
- **Frames Per Second**: (read-only) The frame rate of playback.

**RENDER OPTIONS**

The rendering options for animations are almost identical to the standard **Render (High Quality)** options.
The Ray Brush

With most types of rendering, you have the option to use the Ray Brush. The Render Brush lets you render more important areas in super detail, while spending less time than rendering the entire scene at the same super detail.

You do this by selecting a circular area within which raytracing happens, and outside of which raytracing does not happen. First let the less important parts of your scene render to point you're happy with just them, and then activate the Ray Brush and select a smaller area where raytracing continues to happen for a while longer.

In short, the Ray Brush thereby lets you raytrace selected parts of complex objects at high quality in far less time than raytracing the entire object. Or you can raytrace the entire object to medium quality, and then use the Ray Brush to increase the quality in a few key spots.

USING THE RAY BRUSH

1. As a rendering is happening on your screen, turn on the Ray Brush by clicking its icon in the Toolbar. A circle appears in the 3D Viewport, along with the Ray Brush Controls (see figure).

2. Move the Ray Brush circle over the area of the scene that you wish to raytrace.

3. Adjust the size of the circle by dragging the Radius slider in the Ray Brush Controls. (Note: If Magnification is enabled, then the circle will appear larger than it really is.)

4. Click an area in the scene. Raytracing takes place only within the circle of the Raybrush Tool when and where you clicked.
Chapter 8: Appendix

HOT-KEYS

Using hot-key shortcuts (i.e. keyboard and mouse combinations), you can quickly access many of the functions in Bunkspeed Shot. This section summarizes the functionality of each hot-key.

For most of the hot-keys in the table below, you can hold the Ctrl-Key to make any adjustment in finer steps (i.e. typically 1/10 the step size of the default).

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + N</td>
<td>New File</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save File (.bif)</td>
</tr>
<tr>
<td>Shift + Ctrl + S</td>
<td>Save As (.bif)</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open File (.bif and .bip)</td>
</tr>
<tr>
<td>CTL + W</td>
<td>Close Project</td>
</tr>
<tr>
<td>Ctrl + K</td>
<td>Open Options</td>
</tr>
<tr>
<td>Alt + F4 and Ctrl + Q</td>
<td>Close Application</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>Backspace</td>
<td>Delete</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Mode</td>
<td>Hot-Key</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Toggle Palette</td>
</tr>
<tr>
<td>M</td>
<td>Open Library to Material Tab</td>
</tr>
<tr>
<td>Ctrl + 1</td>
<td>Model Mode</td>
</tr>
<tr>
<td>Ctrl + 2</td>
<td>Material Mode</td>
</tr>
<tr>
<td>Ctrl + 3</td>
<td>Environment Mode</td>
</tr>
<tr>
<td>Ctrl + 4</td>
<td>Plates Mode</td>
</tr>
<tr>
<td>Ctrl + 5</td>
<td>Camera Mode</td>
</tr>
<tr>
<td>Ctrl + 0</td>
<td>Library Mode</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Render Using Current Settings</td>
</tr>
<tr>
<td>Shift + Ctrl + R</td>
<td>Render With Dialog</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Snapshot Using Current Settings</td>
</tr>
<tr>
<td>~</td>
<td>Toggle Raytracing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Hot-Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>F11</td>
<td>Toggle Full Screen</td>
</tr>
<tr>
<td>Tab</td>
<td>Cycle Through Editable Interface Items</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Toggle Heads-Up Display (HUD)</td>
</tr>
<tr>
<td>P</td>
<td>Pause / Resume Real-Time Rendering</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Presentation</th>
<th>Hot-Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + 3</td>
<td>Next Environment</td>
</tr>
<tr>
<td>Shift + Alt + 3</td>
<td>Previous Environment</td>
</tr>
<tr>
<td>Alt + 4</td>
<td>Next Plate</td>
</tr>
<tr>
<td>Shift + Alt + 4</td>
<td>Previous Plate</td>
</tr>
<tr>
<td>Alt + 6</td>
<td>Next Camera</td>
</tr>
<tr>
<td>Shift + Alt + 6</td>
<td>Previous Camera</td>
</tr>
<tr>
<td>Manipulation</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Right Mouse Button Click in Center of Transform Manipulator</td>
<td>Snap Selected Object to Surface</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Selection</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Cycle Through Selection Modes</td>
</tr>
<tr>
<td>Z</td>
<td>Cycle Through Manipulators</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select All</td>
</tr>
<tr>
<td>Shift + Ctrl + A</td>
<td>Deselect All</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Hide Selection</td>
</tr>
<tr>
<td>Shift + Ctrl + U</td>
<td>Show All</td>
</tr>
<tr>
<td>Shift + Ctrl + H</td>
<td>Show Only</td>
</tr>
<tr>
<td>Shift + Ctrl + Right Click</td>
<td>Focus on Selection</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scene</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Toggle Ground Reflections</td>
</tr>
<tr>
<td>G</td>
<td>Flatten Ground</td>
</tr>
<tr>
<td>E</td>
<td>Toggle Environment</td>
</tr>
<tr>
<td>B</td>
<td>Toggle Backplate Image</td>
</tr>
<tr>
<td>Ctrl + Alt + Left Mouse Button</td>
<td>Rotate Environment</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Load Environment Image</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Load Backplate Image</td>
</tr>
<tr>
<td>Control + G</td>
<td>Toggle Grid (when Raytracing is off)</td>
</tr>
<tr>
<td>Shift + Ctrl + [</td>
<td>Decrease Environment Brightness by .05</td>
</tr>
<tr>
<td>Shift + Ctrl + ]</td>
<td>Increase Environment Brightness by .05</td>
</tr>
<tr>
<td>Shift + Ctrl + ;</td>
<td>Decrease Environment Gamma by .05</td>
</tr>
<tr>
<td>Shift + Ctrl + '</td>
<td>Increase Environment Gamma by .05</td>
</tr>
<tr>
<td>Ctrl + [</td>
<td>Decrease Environment Brightness .25</td>
</tr>
<tr>
<td>Ctrl + ]</td>
<td>Increase Environment Brightness .25</td>
</tr>
<tr>
<td>Ctrl + ;</td>
<td>Decrease Environment Gamma .25</td>
</tr>
<tr>
<td>Ctrl + '</td>
<td>Increase Environment Gamma .25</td>
</tr>
</tbody>
</table>
In addition to its native file format (BIF), HyperShot can import a variety of common formats for 3D models, HDR environment images, and standard 2D images. See the following sections for details:

- **Import formats for 3D Models**
- **Import Formats for HDR Environments**
- **Import Formats for Backplates and Textures**

### Import Formats for 3D Models

The following file formats are supported, natively or through plugins that you can download at http://www.bunkspeed.com/BunkspeedShot/downloads.

- SolidWorks 2010 and earlier (SLDASM, SLDPRT) or plugin
- Pro/ENGINEER Wildfire 2, 3, 4 (ASM, PRT) via plugin (Pro/ENGINEER must be installed and licensed)
- Rhino 4.0 and prior (.3DM) direct or via plugin
- SketchUp 7 or prior (.SKP) direct or via plugin
- ALIAS Studio (.WIRE) via plugin (Alias must be installed and licensed)
- Alibre (via IGES or STEP)
• 3D Studio Max (.3DS)
• IGES (IGS)
• STEP (STP)
• OBJ
• Collada (DAE)
• 3DXML

Import Formats for HDR Environments

The text below is adapted from Wikipedia:
http://en.wikipedia.org/wiki/High_dynamic_range_imaging

HDR stands for High Dynamic Range Imaging, which is a set of techniques that allow a much greater range between light and dark areas of an image than normal imaging techniques. HDR is designed to accurately reproduce the wide range of lighting levels found in real scenes from direct sunlight to deep shadows.

Information stored in high dynamic range images usually corresponds to the physical values of luminance or radiance that can be observed in the real world. This is different from traditional digital images, which represent colors that should appear on a monitor or a paper print. Therefore, HDR image formats are often called "scene-referred", in contrast to traditional digital images, which are "device-referred" or "output-referred".

Furthermore, traditional images are usually encoded for the human visual system (maximizing the visual information stored in the fixed number of bits), which is usually called "gamma encoding" or "gamma correction". The values stored for HDR images are often linear, which means that they represent relative or absolute values of radiance or luminance (gamma 1.0).

Bunkspeed Shot uses HDR images for environments that radiate the light in your scenes. Shot supports two formats for HDR images: EXR and HDR. Both are described below.

OPENEXR (EXR)
OpenEXR (.EXR extension) is a high dynamic range imaging image file format that stores a vast exposure range and color depth by providing 32-bits-per-channel of RGB information.

HIGH DYNAMIC RANGE IMAGE (HDR)
High Dynamic Range Images (.HDR extension) is a high dynamic range imaging image file format that stores a vast exposure range and color depth by providing 32-bits-per-channel of RGB information.
Import Formats for Backplates and Textures

Bunkspeed Shot can import the following 2D file types for use as backplates or textures for use in materials. These formats cannot be used as environmental images, and cannot emit light into your project.

- Bitmaps (BMP)
- Targa (TGA)
- GIF
- JPEG (JPG)
- PNG
- TIFF (TIF)

TYPES OF MATERIALS IN BUNKSPEED SHOT

Bunkspeed Shot includes a material library that contains many pre-configured materials. All Bunkspeed Shot materials are based on scientifically accurate materials.

Each type of Bunkspeed Shot material is defined by a unique set of Material Parameters and Texture Properties that simulate a real material, such as glass or leather. When you select a material in the Material Library, or on an object, you can view and edit its Material parameters and Texture properties in the Material Tab of the Palette.

For details on the properties of Color, Specular, Alpha, and Bump textures that you can optionally assign to materials, see Texture Parameters. and “Texture Mapping” on page 29. For details on the Material Parameters that are unique to each type of pre-defined Bunkspeed Shot material, see the sections below:

- Anisotropic
- Emissive
- Flat
- Generic
- Glass
- Gem
- Matte
- Metal
- Metallic Paint
- Paint
- Plastic
**Anisotropic**

The Anisotropic material simulates a surface with an asymmetrical specular highlight that changes when the surface rotates, relative to the light sources. Put another way, an anisotropic material has a "grain" or directionality. This material is most commonly used to simulate brushed finishes on metallic surfaces. The material's parameters are:

- **Base Color**: sets the color of the material in diffuse white light
- **Highlight Color**: sets the color of the material's specular highlights
- **Roughness**: controls the size of the highlight. The rougher the material, the more it diffuses the highlight (i.e. the larger and less focused the highlight becomes).
- **Distortion**: controls the amount of distortion by changing the ratio of roughness in one direction on the surface, versus the perpendicular direction. Zero causes no distortion, and 100 causes maximum distortion.
- **Angle**: sets the direction of the Distortion effect.

**Emissive**

The Emissive material emits light into the scene – provided that you assign a Color texture (the only type of texture supported by emissive materials) and enable the Blend Texture option in the Texture Parameters of Material Tab. If you don’t do this, then the Emissive material will reflect the light that’s shining on it, but will not radiate any additional light into the scene – even if you crank up the Intensity parameter very high.

- **Color**: in the absence of light, the material radiates the Emissive color. In typical scenes, the color the Generic material is the sum of Base Color plus Emissive Color (plus Highlight Color for highlights).
- **Intensity**: multiplies the Color value, by adding luminance (i.e. causing more light to be emitted by the material). Due to clipping in monitors, adding intensity can make the Color appear washed out. To counterbalance this tendency, add saturation to the Color value after increasing Intensity.

**Flat**

The Flat material is not shaded, so it does not react to light or shadows. Hence, the Flat material has a constant color regardless of lighting and shadows. The Flat material is so obviously unrealistic, it is perfectly suited for masking and such.

- **Color**: sets a fixed color for the material. This color does not change regardless of the light falling on the material (i.e. this material is not shaded).
Generic

The Generic material can simulate a wide range of materials – making it possible to precisely control how light interacts with a material. This material's parameters are as follows:

- **Diffuse Color:** sets the color of the material in diffuse white light
- **Specular Color:** sets the color of the material’s specular highlight
- **Transparency Color:** the tint acquired by light passing through partially transparent materials.
- **Diffusion:** how much light diffuses through partly transparent materials.
- **Roughness:** simulates surface roughness by controlling the size of the highlights in reflected light. The rougher the material, the more it diffuses highlights (i.e. the larger and less focused the highlight becomes).
- **Emission:** Causes this material to emit light into the scene.
- **Internal Roughness:** simulates internal roughness that affects light refracting through the material instead of reflected off its surface.
- **IOR:** directly controls how much materials with transparency bend light passing through them; indirectly affects reflectivity.
- **Solid:** toggles two-sided verses one-sided properties (e.g. IOR Out applies only to two-sided objects)
- **Color Density:** adds more of the *Diffuse Color* (i.e. from faint to intense) as the object gets thicker.
Glass
The Glass material is optimized for windows. It can handle thin or thick glass. Typical applications include the windshield and head lamps of an automobile. This material’s parameters are as follows:

- **Solid**: toggles two-sided verses one-sided properties (e.g. IOR Out applies only to two-sided objects)
- **Color**: sets the color of the material in diffuse white light.
- **IOR**: sets the index of refraction (i.e. the amount of bending) of light passing into the glass. When using a surface without thickness, the IOR will affect the reflectivity of the surface, but the light passing through it will not refract. On a surface with thickness, this material will cause light to refract as it passes through the Solid object.
- **IOR Out**: sets the index of refraction (i.e. the amount of bending) of light passing out of the glass. (Note: Transparent objects with thickness, like most gems and glass, refract light when entering and leaving the object.)
- **Thickness (mm)**: determines the intended thickness of the simulated surface, compared to comparable solid glass in reality.
- **Roughness**: controls the size of the highlight. The rougher the material, the more it diffuses the highlight (i.e. the larger and less focused the highlight becomes) – such as with frosted glass.

Gem
The Gem material is a version of the Glass material that’s been optimized for gem stones. This material’s parameters are the same as Glass – except for the addition of the *Abbe Number* parameter.

Matte
This simple material simulates matte surfaces, like flat paint with no specular highlights. This material's parameters are as follows:

- **Color**: sets the color of the material in diffuse white light

Metal
The metal material is used to simulate metals such as aluminum, gold, and silver, with different finishes such as polished, powder coated, cast, etc. This material's parameters are:

- **Color**: sets the color of the metal in diffuse white light
- **Roughness**: determines how much the metal diffuses specular highlights. A value of zero would cause no diffusion at all, which would make the metal appear very smooth with sharp specular highlights.
Metallic Paint
This material simulates metallic paints such as car paints, but can also be used to simulate multilayer plastic finishes. This material's parameters are:

- **Color**: sets the color of the base paint in diffuse white light
- **Metal Color**: sets the color of the metallic flake in diffuse white light
- **Metal Roughness**: determines the degree the metal diffuses specular highlights. A value of zero would cause no diffusion at all, which would make the metal appear very smooth.
- **Metal Coverage**: sets the density of the metallic flakes. If the value is 0, the flake will disappear (0 - 100 range).
- **Clearcoat**: the index of refraction (IOR) of the clear coat. It indirectly determines the surface reflection on the clear coat.

Paint
This material simulates non-metallic paint. Parameters:

- **Color**: sets the color of the material in diffuse white light
- **Clearcoat**: the index of refraction (IOR) of the clear coat. It indirectly determines the surface reflection on the clear coat.
- **Clearcoat Roughness**: determines how much the clearcoat diffuses specular highlights. A value of zero would not diffuse reflections at all, causing specular highlights to be pinpoint sharp.

Plastic
The Plastic material is optimized to simulate many plastic types. This material's parameters are:

- **Color**: sets the color of the material in diffuse white light
- **Highlight Color**: sets the color of the material's specular highlight
- **Transparency Color**: the tint acquired by light passing through partially transparent materials.
- **Diffusion Color**: scattering of light in translucent materials, such as clear plastic.
- **IOR**: directly controls how much the material bends light passing through it, and indirectly affects reflectivity.
- **Roughness**: controls the size of the highlight. The rougher the material, the more it diffuses the highlight (i.e. the larger and less focused the highlight becomes).